Legal Notices

This guide is copyrighted ©2010 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.

Guide Part Number 9320-62015-00 REV B 10/10

Documentation Feedback

At Avid, we are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.
## Contents

### Chapter 1. Welcome to Pro Tools|HD Native  ................................................................. 1
  - Pro Tools|HD Native Systems ................................................................. 1
  - Pro Tools|HD Native Package ............................................................... 1
  - Pro Tools|HD Native Capabilities .......................................................... 2
  - Pro Tools|HD Native Hardware Overview ............................................... 2
  - System Requirements and Compatibility ................................................. 7
  - Registration ......................................................................................... 8
  - Conventions Used in This Guide ............................................................ 8

### Chapter 2. Installing Pro Tools Hardware ............................................................... 9
  - Installing Pro Tools|HD Native Card in a Mac Pro .................................... 9
  - Installing Pro Tools|HD Native Card in a Windows Computer .................. 11
  - Connecting Audio Interfaces .................................................................. 12

### Chapter 3. Installing Pro Tools on Mac ............................................................... 15
  - Installing Pro Tools HD Software .......................................................... 15
  - Launching Pro Tools ............................................................................. 17
  - Additional Software on the Pro Tools Installer Disc .............................. 17
  - Uninstalling Pro Tools .......................................................................... 18
  - Optimizing a Mac System for Pro Tools ................................................. 19

### Chapter 4. Installing Pro Tools on Windows ......................................................... 21
  - Installing Pro Tools HD Software .......................................................... 21
  - Launching Pro Tools ............................................................................. 23
  - Additional Software on the Pro Tools Installer Disc .............................. 24
  - Uninstalling Pro Tools .......................................................................... 24
  - Optimizing a Windows System for Pro Tools ......................................... 25
Chapter 5. Configuring Your Pro Tools|HD Native System ................................. 27
  Starting Up or Shutting Down Your System ............................................. 27
  Configuring the Pro Tools Playback Engine ............................................. 28
  Configuring the Pro Tools Hardware Setup ........................................... 34
  Configuring I/O Setup ............................................................................. 37
  Low Latency Monitoring .......................................................................... 39
  Configuring MIDI Setup .......................................................................... 40
  Backing Up Your System Configuration .................................................. 40

Appendix A. Hard Drive Configuration and Maintenance .............................. 41
  Supported Drive Formats and Drive Types ............................................... 41
  Formatting Audio Drives .......................................................................... 42
  Partitioning Drives .................................................................................. 44
  Defragmenting an Audio Drive ................................................................. 44
  Using Mac Drives on Windows Systems ..................................................... 45
  Hard Disk Storage Space ......................................................................... 45

Appendix B. Configuring CoreAudio (Mac OS X Only) .............................. 47
  CoreAudio Driver Capabilities ................................................................. 47
  Installing the CoreAudio Driver ............................................................... 47
  CoreAudio Manager .................................................................................. 48
  Configuring a Pro Tools|HD Audio Interface for Third-Party Applications .... 50
  Configuring the Apple Sound Preferences or Apple Audio MIDI Setup ......... 51

Appendix C. Configuring MIDI Setup (Mac OS X Only) ............................. 53
  MIDI Setup ............................................................................................... 53
  MIDI Patch Name Support ....................................................................... 56

Appendix D. Configuring ASIO (Windows Only) ........................................ 57
  ASIO Driver Capabilities .......................................................................... 57
  Installing the ASIO Driver ........................................................................ 57
  ASIO Driver Control Panel ...................................................................... 57
Pro Tools®|HD Native provides high-definition digital audio recording, editing, signal processing, mixing, and I/O capabilities.

This guide covers installation and configuration of Pro Tools|HD Native hardware and Pro Tools HD software on Mac and Windows platforms.

Pro Tools|HD Native Systems

All Pro Tools|HD Native systems consist of the following:

- Pro Tools HD software
- Pro Tools|HD Native PCIe card
- Up to four of the following Pro Tools|HD audio interfaces:
  - HD OMNI
  - HD I/O
  - HD MADI
  - 192 I/O™
  - 192 Digital I/O™
  - 96 I/O™
  - 96i I/O™

⚠️ Only one HD OMNI can be used in a single Pro Tools|HD Native system.

Additional Hardware Options

Pro Tools|HD Native systems also support the following Pro Tools hardware options:

- SYNC HD™
- SYNC I/O™
- PRE™
- MIDI I/O
- Worksurfaces and control surfaces:
  - D-Control™
  - D-Command®
  - C|24™
  - Command|8®

Pro Tools|HD Native Package

The Pro Tools|HD Native package includes the following:

- Pro Tools|HD Native PCIe card
- 12’ DigiLink™ Mini cable for connecting the Pro Tools|HD Native card to an audio interface
- DigiLink Mini to DigiLink adapter cable
- Pro Tools HD Installer disc
- iLok for running Pro Tools HD software
- Activation card for Pro Tools HD software
- Registration Information Card
- This User Guide, covering installation and configuration of Pro Tools|HD Native
Pro Tools|HD Native Quick Setup, covering basic hardware and software installation

Health and Safety Guide

For more information on the print, electronic, and web-based resources available to help you use Pro Tools, see Appendix H, “Resources.”

Pro Tools|HD Native Capabilities

Pro Tools|HD Native on Mac or Windows provides the following capabilities:

- Up to a total of 192 voiced audio tracks (up to 256 viewable audio tracks), 160 Auxiliary Input tracks, 64 Master Fader tracks, 128 VCA Master tracks, 256 MIDI tracks, 128 Instrument tracks, and 64 video tracks per session
- 16-bit or 24-bit audio resolution, at sample rates up to 192 kHz
- Low Latency Monitoring
- Up to 7.1 surround mixing capability
- Non-destructive, random-access editing and mix automation
- Automatic Delay Compensation
- Support for host-based audio processing plug-ins with up to 10 RTAS plug-ins per track, depending on your computer’s capabilities
- Up to 10 hardware inserts per track
- Up to 10 sends per track
- Up to 128 internal mix busses

Audio Recording and Playback Capabilities

Pro Tools|HD Native provides recording and playback of 24-bit or 16-bit audio files up to the following voiced-track counts:

- Up to 192 tracks at 44.1 kHz or 48 kHz
- Up to 96 tracks at 88.2 kHz or 96 kHz
- Up to 32 tracks at 176.4 kHz or 192 kHz

Pro Tools|HD Native Hardware Overview

This section describes each hardware component of a Pro Tools|HD Native system.

Pro Tools|HD Native PCIe Card

The Pro Tools|HD Native PCIe card supports up to 64 channels of I/O for direct-to-disk recording and playback (up to 192 tracks with Pro Tools HD software), and supports up to 24-bit and up to 192 kHz sessions. Additionally, the on-board FPGA provides processing power for mixer configurations and low latency monitoring with Pro Tools.
DigiLink Mini Ports The Pro Tools|HD Native PCIe card includes two DigiLink Mini ports for connecting up to 32 channels of audio input and output each to your Pro Tools system.

DigiSerial Port The DigiSerial port on the Pro Tools|HD Native PCIe card is for connecting a SYNC peripheral. This connector is an 8-pin mini-DIN.

⚠️ The DigiSerial port on a Pro Tools|HD Native PCIe card does not support Machine-Control connections.

Audio Interfaces

To record and play audio with Pro Tools HD, you must have at least one Pro Tools|HD audio interface connected to the Pro Tools|HD Native card. Pro Tools|HD Native systems support up to 4 Pro Tools|HD audio interfaces for up to 64 simultaneous channels of input and output.

⚠️ Pro Tools does not support legacy Pro Tools|24 MIX™ audio interfaces (such as the 888|24 or 882|20).

HD OMNI

HD OMNI is a professional digital audio interface designed for use with Pro Tools|HD and Pro Tools|HD Native systems. HD OMNI provides a compact preamp, monitoring, and I/O solution for music production and recording, and post production studios.

⚠️ Only one HD OMNI can be used in a single Pro Tools|HD Native system.

HD OMNI Features

HD OMNI provides up to 8 discrete channels of Pro Tools input and output, with 4-segment LED meters for input or output (selectable).

Analog I/O

- 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, with support for sample rates up to 192 kHz
- 2 high-quality Mic/DI preamps (Channels 1–2)
- 2 combined XLR and 1/4-inch TRS front panel inputs for microphone and instrument level input
- 2 XLR back panel microphone inputs
- 2 1/4-inch TRS Send and 2 1/4-inch TRS Return back panel jacks for hardware inserts on channels 1 and 2
- 4 analog TRS line level back panel inputs (Channels 1–4)

⚠️ HD OMNI provides multiple analog input connections, but only provides up to four channels of simultaneous analog input for Pro Tools.

- Soft Clip and Curv limiting circuits to protect against clipping on analog input.
- 8 channels of analog back panel output using a DB-25 breakout cable (sold separately) with variable output gain
- 2 channels of analog back panel output using TRS (Mirrors channels 1–2 or 7–8 on DB-25 connector)
- Front panel stereo 1/4” headphone jack

Digital I/O

- 8 channels of AES/EBU output (up to 192 kHz Single Wire) using a DB-25 breakout cable (sold separately)
• 2 channels of AES/EBU XLR input (up to 192 kHz Single Wire)
• 2 channels of S/PDIF RCA input and output (up to 192 kHz)
• 8 channels of ADAT TOSLINK input and output
• Support for ADAT S/MUX Optical for sample rates of 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz.
• Support for two channels of S/PDIF Optical with sample rates of up to 96 kHz.
• Real-time sample rate conversion (SRC) on Digital Inputs 1–2 of either AES/EBU, S/PDIF, or Optical (S/PDIF)

⚠️ **SRC is not supported with ADAT S/MUX.**

### Monitoring
- An additional stereo “CUE” output path in Pro Tools for headphone monitoring from the front panel headphone jack
- Front panel Control Room (MAIN/ALT) and Headphone monitoring volume control
- Flexible monitoring with fold-down from all stereo and surround formats (up to 7.1 surround)
- Input mixer for low latency direct monitoring of a variety of incoming signals (configured in the Pro Tools Hardware Setup)

### Synchronization
- Loop Sync input and output for connecting additional Pro Tools|HD interfaces and peripherals
- External Clock input and output for synchronizing HD OMNI with external Word Clock devices.

For more information about HD OMNI, see the HD OMNI Guide.

### HD I/O

HD I/O is a multichannel digital audio interface designed for use with Pro Tools|HD and Pro Tools|HD Native systems. HD I/O features extremely high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 192 kHz.

HD I/O comes in three standard configurations:
- 8 x 8 x 8 (8 analog in, 8 analog out, and 8 digital in and out)
- 16 x 16 analog in and out
- 16 x 16 digital in and out

You can also add or remove HD I/O Analog Expansion cards (ADC and DAC) and HD I/O Digital Expansion cards for custom configurations.

### HD I/O Features

HD I/O provides up to 16 discrete channels of Pro Tools input and output, with 4-segment LED meters for input and output.

#### Analog I/O
- Up to sixteen channels of 24-bit D/A and A/D converters for superior analog input and output at sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz with Analog In and Analog Out HD I/O cards
- Soft Clip and Curv limiting circuits to protect against clipping on analog input.

#### Digital I/O
- Up to sixteen channels of 24-bit digital I/O, using AES/EBU, TDIF DB-25, or Optical at sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz with a Digital HD I/O card
- Real-time sample rate conversion on digital inputs with a Digital I/O card (up to sixteen channels of AES/EBU, Optical, or TDIF)
• Support for S/MUX Optical for sample rates of 88.2 kHz and higher
• Support for 2 channels of S/PDIF Optical (enclosed) with sample rates of up to 96 kHz
• 2 channels of AES/EBU I/O (enclosed) with support for sample rates up to 192 kHz
• 2 channels of 24-bit-capable S/PDIF I/O (enclosed) with support for sample rates up to 192 kHz

Synchronization
• Loop Sync input and output for connecting additional Pro Tools|HD interfaces and peripherals
• External Clock input and output for synchronizing HD I/O with external Word Clock devices

Expandability
• Optional addition of I/O cards to expand analog or digital I/O
• Simultaneous use of multiple Pro Tools|HD audio interfaces to further expand system input and output (for more information see the Expanded Systems Guide)

For more information about HD I/O, see the HD I/O Guide.

HD MADI

HD MADI is a 64-channel, digital audio interface designed for use with Pro Tools|HD and Pro Tools|HD Native systems. HD MADI supports the Multichannel Audio Digital Interface (MADI) format and sample rates of up to 192 kHz. HD MADI provides simplified connectivity between your Pro Tools|HD or Pro Tools|HD Native system and MADI-compatible audio equipment, such as routers, digital mixing consoles, and converters.

To use the full channel capacity of HD MADI, only a single HD MADI can be connected to a Pro Tools|HD Native card using two DigiLink Mini cables. No additional I/O may be used with this configuration.

HD MADI Features
• 2 MADI Optical and Coaxial inputs and 2 MADI Optical and Coaxial outputs for up to 64 discrete channels of digital input and output (32 channels per DigiLink Mini port)
• Supports sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz
• 24- or 16-bit resolution
• Sample Rate Conversion (SRC) on input or output
• Front panel clock and SRC indicators
• Front panel signal present LEDs for input and output
• BNC Word Clock I/O for synchronizing HD MADI with external 1x Word Clock
• BNC Loop Sync I/O for synchronizing HD MADI with additional Pro Tools|HD audio interfaces and peripherals (such as HD I/O, HD OMNI, or SYNC HD)
• Dedicated BNC Word Clock input and XLR AES/EBU input (clock input only) for external MADI synchronization (when using SRC on output)
• Clock support for the following formats: Internal, Loop Sync, Word Clock, AES/EBU, and MADI
• Varispeed modes (supports both 64- and 56-channel standards)

For more information about HD MADI, see the HD MADI Guide.
192 I/O Audio Interface

192 I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems. 192 I/O features high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 192 kHz.

You can also add or remove analog cards (ADC and DAC) and digital cards for custom configurations.

⚠️ A DigiLink to DigiLink Mini adapter cable is required to connect 192 I/O to the Pro Tools|HD Native card.

192 I/O Features

- Supports sample rates up to 192 kHz.
- Supports both analog and digital connections, including AES/EBU, S/PDIF, TDIF, and ADAT Optical:
  - Digital (Digital I/O Card): 8 channels, DB-25 (AES/EBU and TDIF), or one pair of Lightpipe (ADAT Optical) connectors. Expandable up to 16 of channels digital I/O with the addition of the 192 Digital expansion card.
  - Analog: 8 channels, DB-25 (balanced) connectors, inputs selectable between +4 dBu or -10 dBV, outputs +4 dBu only. Expandable up to 16 analog inputs or 16 outputs using an optional 192 AD or 192 DA expansion card, respectively.
  - Digital (Enclosure): 2 channels, XLR (AES/EBU) connectors; 2 channels RCA (S/PDIF) connectors.
  - Optical (Enclosure): 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF).
- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals.
- External Clock In and Out receive or send 1x Word clock.

For more information, see the 192 I/O Guide.

192 Digital I/O Audio Interface

192 Digital I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems, and supports sample rates of up to 192 kHz.

⚠️ A DigiLink to DigiLink Mini adapter cable is required to connect 192 Digital I/O to the Pro Tools|HD Native card.

192 Digital I/O Features

- Supports sample rates up to 192 kHz.
- Supports digital connections, including AES/EBU, S/PDIF, TDIF, and ADAT Optical:
  - Digital (2 Digital I/O Cards): 16 channels, DB-25 (AES/EBU and TDIF), or two pairs of Lightpipe (ADAT Optical) connectors.
  - Digital (Enclosure): 2 channels, XLR (AES/EBU) connectors; 2 channels RCA (S/PDIF) connectors.
  - Optical (Enclosure): 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF).
- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals.
- External Clock In and Out receive or send 1x Word clock.

For more information, see the 192 Digital I/O Guide.
**96 I/O Audio Interface**

96 I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems. 96 I/O features high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 96 kHz.

⚠️ A DigiLink to DigiLink Mini adapter cable is required to connect 96 I/O to the Pro Tools|HD Native card.

**96 I/O Features**

- Supports sample rates up to 96 kHz.
- Supports analog and digital connections, including AES/EBU, S/PDIF, and ADAT optical:
  - Analog: 8 channels, 1/4-inch TRS (balanced or unbalanced) connectors, +4 dBu or –10 dBV.
  - Digital: 2 channels, XLR (AES/EBU) connectors; 2 channels, RCA (S/PDIF) connectors.
  - Optical: 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF).
- External Clock In and Out receive or send 1x Word clock.

⚠️ For more information, see the 96 I/O Guide.

**96i I/O Audio Interface**

96i I/O is a multichannel digital audio interface designed for use with Pro Tools|HD systems. 96i I/O features high quality 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters, and supports sample rates of up to 96 kHz.

⚠️ A DigiLink to DigiLink Mini adapter cable is required to connect 96i I/O to the Pro Tools|HD Native card.

**96i I/O Features**

- Supports sample rates up to 96 kHz.
- 16 discrete channels of input, and 2 channels of output, with 4-segment LED meters on each channel. Audio inputs and outputs include:
  - 16 channels of 24-bit, 96-kHz capable analog input, with adjustable input sensitivity.
  - 2 channels of 24-bit, 96-kHz capable analog output, with selectable operating level.
  - 2 channels of 24-bit, 96 kHz-capable digital S/PDIF RCA input and output.
- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals.
- External Clock In and Out receive or send 1x Word clock.

⚠️ For more information, see the 96i I/O Guide.

**System Requirements and Compatibility**

Pro Tools|HD Native can be used with a qualified Mac or Windows computer running Pro Tools HD software.

A DVD drive is required to use the Pro Tools Installer disc.

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, refer to the latest information on our website:

www.avid.com/compatibility
**MIDI Requirements**

USB MIDI interfaces (such as the M-Audio MIDI-SPORT series) and USB MIDI controllers (such as the M-Audio Axiom Pro series) work effectively with Pro Tools systems on Windows or Mac.

For a list of supported MIDI interfaces and controllers, refer to our website (www.avid.com).

**Hard Drive Requirements**

For optimal audio recording and playback, Pro Tools|HD Native systems require one or more qualified hard drives.

Initialize your hard drives with the Disk Utility application included with Apple System software (Mac) or using Windows Disk Management (Windows).

> For general hard drive maintenance and configuration information, see Appendix A, “Hard Drive Configuration and Maintenance.”

**Registration**

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. This is one of the most important steps you can take as a new user. Registering your purchase is the only way you can be eligible to receive:

- Information regarding technical support
- Future upgrade offers
- Limited warranty on hardware

---

**Conventions Used in This Guide**

All Pro Tools guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the Next key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 **User Tips** are helpful hints for getting the most from your Pro Tools system.

⚠️ **Important Notices** include information that could affect your Pro Tools session data or the performance of your Pro Tools system.

🔍 **Shortcuts** show you useful keyboard or mouse shortcuts.

صلة **Cross References** point to related sections in the Pro Tools Guides.
chapter 2

Installing Pro Tools Hardware

This chapter provides information on installing and connecting the Pro Tools|HD Native card and Pro Tools|HD audio interfaces. Install your Pro Tools|HD hardware before installing Pro Tools HD software.

To install Pro Tools|HD hardware, first install the Pro Tools|HD Native card. Once the card is installed, connect Pro Tools|HD audio interfaces.

Installing Pro Tools|HD Native Card in a Mac Pro

The PCI Express-equipped Mac Pro has three PCI Express (PCIe) slots (named slots 2, 3, and 4). The PCI Express slot numbers increase from bottom to top as you face the open computer case from the side. Install the Pro Tools|HD Native PCIe card into PCIe slot 2.

⚠️ Follow these instructions carefully to avoid damaging the card and its components.

⚠️ Pro Tools|HD Native is supported with Mac Pro only. PowerPC Macs are not supported.
To install the Pro Tools|HD Native card:

1. Turn off your computer and any peripherals. Leave your computer's power cable plugged in so that the computer is grounded.

2. Disconnect all cables attached to the computer (such as hard drives, displays, and USB and FireWire devices) except for the power cable.

3. Lay the computer on its side so the access panel is facing up.

4. Open the computer case using the latch located on the back of the computer.

5. Remove the clamp that secures the metal access port covers to the chassis.

6. Remove the metal access port covers for the lowest numbered PCIe slot.

⚠️ Before handling the card, discharge static electricity from your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer with the power cable connected.

7. Install the Pro Tools|HD Native PCIe card into the lowest numbered slot in the computer. With the card’s PCIe connectors facing down, carefully insert the card straight down and firmly seat the card’s PCIe connector into the PCIe slot.

8. Ensure that any additional cards are installed in the proper order for your system, starting with the lowest numeric slot:
   - Display card for your computer monitor
   - Pro Tools|HD Native PCIe card
   - Avid-approved video capture card (optional)

9. Reattach the clamp that secures the cards and the slot covers to the chassis.

⚠️ The card’s PCIe connectors will not seat completely until you have replaced the clamp that secures the cards and the metal access port covers to the chassis.
Installing Pro Tools|HD Native Card in a Windows Computer

To install the Pro Tools|HD Native card:

1. Turn off your computer and any peripherals. Leave your computer’s power cable plugged in so the computer is grounded.

2. Disconnect all cables attached to the computer (such as hard drives, displays, and USB and FireWire devices) except for the power cable.

3. Open the computer case.

4. Remove the metal access port cover behind the slot you want to use by removing the screw and sliding the cover out from the access port.

⚠️ Before handling any card, discharge static electricity from your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer.

5. Install the Pro Tools|HD Native card in the first available PCIe slot (typically, it will be the slot right next to the video card).

6. Secure the card in place with the slot access port screw you removed earlier.

7. Ensure that any additional cards are installed in the proper order for your system, starting with the lowest numeric slot:
   - Display card for your computer monitor
   - Pro Tools|HD Native card (for PCIe)
Connecting Audio Interfaces

Each Pro Tools|HD audio interface provides several different input and output options. For example, HD OMNI supplies up to 8 channels of input and output to your Pro Tools system, HD I/O supplies up to 16 channels of input and output, and HD MADI provides up to 64 channels. Audio interfaces can be connected directly to the Pro Tools|HD Native card, or through the Expansion ports on other Pro Tools|HD audio interfaces.

At least one Pro Tools|HD audio interface must be connected to the Pro Tools|HD Core card for Pro Tools to launch.

The Pro Tools|HD Native card supports up to 64 channels of audio input and output. To get a full 64 channels of I/O, you can connect up to four 16-channel Pro Tools|HD audio interfaces to the Pro Tools|HD Native card. Two of the interfaces connect directly to DigiLink Mini Ports 1 and 2, and the other 2 interfaces connect to the Expansion ports on those Pro Tools|HD audio interfaces.

You can also get a full 64 channels of I/O with HD MADI connected to the Pro Tools|HD Native card using 2 DigiLink Mini cables. However, HD MADI will be the only audio interface in the system.


- Front and back panel connectors and indicators
- Installation of optional expansion I/O cards (HD I/O and 192 I/O only)

Pro Tools|HD Native supports up to a maximum combination of up to four total of the following audio interfaces:

- HD OMNI (only one HD OMNI is supported in a single Pro Tools|HD Native system)
- HD I/O
- HD MADI
- 192 I/O
- 192 Digital I/O
- 96 I/O
- 96i I/O

For an example of connecting multiple Pro Tools|HD audio interfaces, see Figure 2 on page 13.

Pro Tools|HD audio interfaces need room at their sides to maintain proper air flow for cooling. Do not block the sides of the unit or disconnect the internal fan. If the units are rack-mounted in a case, remove the case lids or doors before operating the system. Failure to do so can result in the units overheating very quickly, which can permanently damage sensitive components.
To connect Pro Tools audio interfaces:

1. If you are using a single Pro Tools|HD audio interface (such as HD OMNI), connect the Primary Port to DigiLink Mini Port 1 on the Pro Tools|HD Native card with the included DigiLink Mini cable. You must attach at least one Pro Tools|HD audio interface to your system in order for Pro Tools to launch.

2. Connect an additional Pro Tools audio interface by doing one of the following:
   - Connect the Primary Port of the secondary interface to the Expansion Port of the primary interface with an additional DigiLink Mini (or DigiLink Mini to DigiLink cable).
   - or –
   - Connect the Primary Port of the secondary interface to DigiLink Mini Port 2 on the Pro Tools|HD Native card.

3. Make the necessary Loop Sync connections.

Connecting Loop Sync

If you are using two (or more) Pro Tools audio interfaces or a SYNC peripheral, Loop Sync must be connected to maintain proper clock among the devices.

To make Loop Sync connections:

1. Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with the BNC cables included in your I/O packaging.

2. Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC peripheral.
chapter 3
Installing Pro Tools on Mac

This chapter contains information for Mac systems only. If you are installing Pro Tools on a Windows computer, see Chapter 4, “Installing Pro Tools on Windows.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

Installing Pro Tools HD Software

After all Pro Tools|HD Native hardware is installed and connected, install Pro Tools HD software.

⚠️ Do not install or operate Pro Tools while logged in as a root-level user. File permissions of a root-level user make it possible to perform actions that may conflict with Pro Tools file management tasks.

To install Pro Tools HD software:

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, refer to your Apple OS X documentation.

2. Insert the Pro Tools HD Installer disc in your DVD drive.

3. On the Installer disc, locate and double-click the Install Pro Tools HD.mpkg file.

4. Follow the on-screen instructions to proceed with installation.

5. Click Continue each time you are prompted.

6. At the Installation Type page, do one of the following:
   - To install all Pro Tools application files and included plug-in suites (and associated content), leave the default Installation options selected and click Continue.
   - or –
   - Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 16) and click Continue.

7. Click Install.

8. If prompted, enter your Administrator password and click OK to accept the installation.

9. Click Continue.

10. When installation is complete, click Restart.
Installation Options

Pro Tools HD Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the reveal triangle for the Pro Tools HD 8.5 option in the installer, and deselect any of the following options that you do not want installed.

Application Files (Required for Pro Tools) Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option also installs the CoreAudio Driver. This option must be selected to install Pro Tools.

Free Plug-Ins Installs free plug-ins including DigiRack™ plug-ins, free Bomb Factory plug-ins, Eleven Free, TL Utilities, and the D-Fi and Maxim plug-ins. For more information, see the Audio Plug-Ins Guide.

Pro Tools Utilities Installs Calibration Mode Templates for Pro Tools|HD Native systems, DigiTest™, and firmware updaters for SYNC I/O and SYNC HD.

Pro Tools Creative Collection Options

Select any of the Pro Tools Creative Collection options you want installed. For more information, see the Audio Plug-Ins Guide.

Effect Plug-Ins Installs 6 free virtual instrument plug-ins from Avid’s AIR group.

Virtual Instruments Installs 20 free effects plug-ins from Avid’s AIR group.

Virtual Instrument Content Installs sample content for AIR virtual instruments.

⚠ Virtual Instrument content is very large and may take up to 20 minutes to install. During this time, the progress bar may not appear to move but your software is still installing. Do not terminate your installation.

Additional Options

The Pro Tools installer provides the following additional options to install along with Pro Tools software and plug-ins.

CoreAudio Driver This option installs the CoreAudio Driver, which lets you use Pro Tools audio interfaces with third-party applications that support the CoreAudio standard. (For information on configuring the CoreAudio Driver, see Appendix B, “Configuring CoreAudio (Mac OS X Only).”)

Avid Video Engine The Avid Video Engine is required to use Pro Tools with Avid video peripherals such as the Avid Mojo® SDI.

MIDI I/O Driver The MIDI I/O Driver is required if you are using the MIDI I/O interface.

Authorizing Pro Tools HD Software

Pro Tools software is authorized using the iLok USB Smart Key (iLok) from PACE Anti-Piracy. Your Pro Tools|HD Native system includes an iLok and Activation Code (on the included Activation Card) for Pro Tools software.
To authorize Pro Tools HD software using an Activation Code:

1. If you do not have an iLok.com account, visit www.iLok.com and sign up for an account.
2. Transfer the license for your software to your iLok.com account by doing the following:
   - Visit www.avid.com/activation.
   - Input your Activation Code (listed on your Activation Card) and your iLok.com User ID. Your iLok.com User ID is the name you create for your iLok.com account.
3. Transfer the license from your iLok.com account to your iLok USB Smart Key by doing the following:
   - Insert the iLok into an available USB port on your computer.
   - Go to www.iLok.com and log in.
   - Follow the on-screen instructions for transferring your license to your iLok.

For more information, visit the iLok website (www.iLok.com).

Launching Pro Tools

To use Pro Tools, you must always have an inserted iLok with an authorization for Pro Tools.

To launch Pro Tools HD software:

1. Make sure your Pro Tools hardware is powered on.
2. Insert your Pro Tools HD authorized iLok into any available USB port on your computer.

Do not remove the iLok during Pro Tools launch or use.

3. Do one of the following:
   - Click the Pro Tools icon in the Dock.
   - Locate and double-click the Pro Tools application on your hard drive.
4. Use the Quick Start dialog to do one of the following:
   - Create a new session from a template.
   - Create a new blank session.
   - Open a session.

For more information on the Quick Start dialog and session templates, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).

Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including third-party applications and plug-ins, audio drivers (for playing other audio applications through your Pro Tools hardware) and a Pro Tools demo session.

Refer to your Pro Tools Installer disc for additional software and installers.

Third-Party Applications and Plug-Ins

Your Pro Tools package also includes free applications and plug-ins from Avid and Avid Third Party developers. Once you have completed installing Pro Tools, you can install these separately.

Installers are located on your Pro Tools Installer disc in the Additional Files/3rd Party Content folder.
**Pro Tools Demo Session**

The Pro Tools Installer disc includes a demo session that you can use to verify that your system is working. The demo session for Pro Tools is named *Meant To Be*.

⚠️ *Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting Audio Drives” on page 42.*

**To install the demo session:**

1. Insert the Pro Tools Installer disc into your DVD drive.

2. On the installer disc, in the Additional Files folder, locate and open the Pro Tools Demo Session Installer folder.


4. Follow the on-screen instructions to proceed with installation.

5. When prompted, select your audio drive as the install location and click Continue to begin the install.

6. Click Install.

7. When installation is complete, click Close.

The demo session can be opened by double-clicking the *Meant To Be*.ptf file found in the Pro Tools Demo Session folder.

---

**Uninstalling Pro Tools**

If you need to uninstall Pro Tools software from your computer, use the Uninstaller application.

**To remove Pro Tools from your computer:**

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.

2. Go to Applications/Digidesign/Pro Tools/Pro Tools Utilities and double-click the “Uninstall Pro Tools” file.

3. Click Continue to proceed with the uninstall.

4. Choose the type of uninstall you want to perform:

   - **Safe Uninstall** Leaves certain plug-ins and system files needed for compatibility with some Avid products.
   - **Clean Uninstall** Removes all Pro Tools files, including system files, Pro Tools plug-ins, and MIDI patch names.

5. Click Uninstall.

6. Enter your Administrator password and click OK.

7. Click Finish to close the Installer window.
Optimizing a Mac System for Pro Tools

To ensure optimum performance with Pro Tools, configure your computer first.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

⚠️ Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified versions of Mac OS, see the latest compatibility information on our website (www.avid.com).

Turning Off Software Update

To turn off the Software Update feature:

1. Choose System Preferences from the Apple menu.
2. Click Software Update.
3. Click the Scheduled Check tab.
4. Deselect Check for Updates.
5. When you are done, choose System Preferences > Quit System Preferences.

Turning Off Energy Saver

To turn off the Energy Saver feature:

1. Choose System Preferences from the Apple menu.
2. Click Energy Saver.
3. Set the Computer Sleep setting to Never.
4. Set the Display Sleep setting to Never.
5. Deselect “Put the hard disk(s) to sleep when possible” option.
6. When you are done, choose System Preferences > Quit System Preferences.

Disable or Reassign Mac Keyboard Shortcuts Used by Pro Tools

To have the full complement of Pro Tools keyboard shortcuts, you need to disable or reassign any conflicting Mac OS X Keyboard Shortcuts in the Apple System Preferences.

To disable or reassign Mac keyboard shortcuts used by Pro Tools:

1. From the Apple menu, choose System Preferences.
2. Click Keyboard.
3. Click the Keyboard Shortcuts tab.
4. Disable or reassign the following:
   - Under “Dashboard & Dock”
     - “Turn Dock Hiding On/Off”
     - “Dashboard”
   - Under “Exposé and Spaces”
     - “All windows”
     - “Application windows”
     - “Desktop”
   - Under “Keyboard & Text Input”
     - “Move focus to the window drawer”
   - Under “Spotlight”
     - “Show Spotlight search field”
     - “Show Spotlight window”
   - Under “Application Shortcuts”
     - “Show Help menu”

For a complete list of Pro Tools keyboard shortcuts, see the Keyboard Shortcuts Guide (Help > Keyboard Shortcuts).
Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign the Spaces keyboard shortcuts to avoid conflicts with important Pro Tools keyboard shortcuts. You can reassign Spaces keyboard shortcuts to use a combination of modifier keys (Command+Option+Control+Shift) in addition to the default Spaces keyboard shortcut assignments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use modifier key combinations that do not conflict with Pro Tools keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Exposé & Spaces.
2. Click the Spaces tab.
3. Ensure that Enable Spaces is selected.
4. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+F8” from the “To activate Spaces” pop-up menu.
5. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Arrow Keys” from the “To switch between spaces” pop-up menu.
6. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Number Keys” from the “To switch directly to a space” pop-up menu.

Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically indexes files and folders on local hard drives in the background. In most cases, this is not a concern for normal Pro Tools operation. However, if Spotlight starts indexing drives while recording in a Pro Tools session with high track counts for an extended period of time, it can adversely affect Pro Tools system performance. You may want to disable Spotlight indexing for all local drives before using Pro Tools for big recording projects.

⚠️ Disabling Spotlight indexing also disables the Find function in Mac OS X.

To disable Spotlight indexing:

1. Choose System Preferences from the Apple menu and click Spotlight.
2. In the Spotlight window, click the Privacy tab.
3. To prevent indexing of a drive, drag its icon from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:

1. Launch the Disk Utility application, located in Applications/Utilities.
2. Select the volume in the left column of the Disk Utility window.
3. Select Enable Journaling in the toolbar.
This chapter contains information for Windows systems only. If you are installing Pro Tools on a Mac computer, see Chapter 3, “Installing Pro Tools on Mac.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

### Installing Pro Tools HD Software

After all Pro Tools|HD Native hardware is installed and connected, install Pro Tools software.

**To install Pro Tools HD software:**

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.

2. Wait for the Found New Hardware Wizard dialog to appear and leave it open: Do not click Next.

3. Insert the Pro Tools HD Installer disc in your DVD drive and do one of the following:
   - If Windows AutoRun is enabled, a mini-browser appears. Select Install Pro Tools to begin your installation.
   - or –
   - If Windows AutoRun is disabled, locate and double-click Setup.exe on the Installer disc.

4. Follow the on-screen instructions to proceed with installation and click Next when prompted.

5. At the Select Features page, do one of the following:
   - To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.
   - or –
   - Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 22) and click Continue.

6. Click Next.

7. Click Install.
| Several messages are displayed during installation that can be ignored, including multiple “Found New Hardware” dialogs and “A Problem Occurred During Hardware Installation.” |

Additionally, if you get a warning dialog about the driver not passing Windows Logo testing, click Continue Anyway.

Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

When installation is complete, click Finish.

### Installation Options

#### Pro Tools Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the plus (+) next to Pro Tools 8.5 option in the Select Features page of the installer, and deselect any of the following options that you do not want installed.

**Application Files (Required for Pro Tools)**
Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option must be selected to install Pro Tools.

**Free Plug-Ins**

**Pro Tools Utilities**
Installs Calibration Mode Templates for Pro Tools|HD Native systems, DigiTest, and firmware updaters for SYNC I/O and SYNC HD.

#### Pro Tools Creative Collection Options

Select any of the Pro Tools Creative Collection options you want installed. For more information, see the *Audio Plug-Ins Guide*.

**Effect Plug-Ins**
Installs 6 free virtual instrument plug-ins from Avid’s AIR group.

**Virtual Instruments**
Installs 20 free effects plug-ins from Avid’s AIR group.

**Virtual Instrument Content**
Installs sample content for AIR virtual instruments.

**Virtual Instrument content is very large and may take up to 20 minutes to install. During this time, the progress bar may not appear to move but your software is still installing. Do not terminate your installation.**

#### Additional Options

The Pro Tools installer provides the following additional options to install along with Pro Tools software and plug-ins.

**Mac HFS+ Disk Support Option**
This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks. HFS+ disks are commonly referred to as Mac OS Extended disks.

**Avid Video Engine**
The Avid Video Engine is required to use Pro Tools with Avid video peripherals such as the Avid Mojo SDI.

**Command|8 Controller and Driver**
The Command|8 Driver is required if you are using the Command|8 control surface.
Installing QuickTime

QuickTime is required for Pro Tools if you plan to include movie files, or import MP3 or MP4 (AAC) files in your sessions. QuickTime for Windows is available as a free download from the Apple website.

⚠️ For information on which version of QuickTime is compatible with your version of Pro Tools, visit the compatibility pages of our website (www.avid.com).

To install QuickTime:

2. Double-click the QuickTime installer application and follow the on-screen installation instructions.
3. Restart your computer.

💡 If you turned off Driver Signing Warning on your computer, be sure to enable it once Pro Tools hardware and software have been installed.

Authorizing Pro Tools HD Software

Pro Tools software is authorized using the iLok USB Smart Key (iLok) from PACE Anti-Piracy. Your Pro Tools|HD Native system includes an iLok and Activation Code (on the included Activation Card) for Pro Tools software.

To authorize Pro Tools HD software using an Activation Code:

1. If you do not have an iLok.com account, visit www.iLok.com and sign up for an account.
2. Transfer the license for your software to your iLok.com account by doing the following:
   - Visit www.avid.com/activation.
   - Input your Activation Code (listed on your Activation Card) and your iLok.com User ID. Your iLok.com User ID is the name you create for your iLok.com account.
3. Transfer the license from your iLok.com account to your iLok USB Smart Key by doing the following:
   - Insert the iLok into an available USB port on your computer.
   - Go to www.iLok.com and log in.
   - Follow the on-screen instructions for transferring your license to your iLok.

⚠️ For more information, visit the iLok website (www.iLok.com).

Launching Pro Tools

To use Pro Tools, you must always have an inserted iLok with an authorization for Pro Tools.

To launch Pro Tools HD software:

1. Make sure your Pro Tools hardware is powered on.
2. Insert your Pro Tools HD authorized iLok into any available USB port on your computer.

⚠️ Do not remove the iLok during Pro Tools launch or use.
3 Do one of the following:
   • Double-click the Pro Tools shortcut on the desktop.
   – or –
   • Locate and double-click the Pro Tools application on your hard drive.
4 Use the Quick Start dialog to do one of the following:
   • Create a new session from a template.
   • Create a new blank session.
   • Open a session.

For more information on the Quick Start dialog and session templates, see the Pro Tools Reference Guide.

Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including third-party applications and plug-ins, audio drivers (for playing other audio applications through your Pro Tools hardware), and a Pro Tools demo session.

Refer to your Pro Tools Installer disc for additional software and installers.

Third-Party Applications and Plug-Ins

Your Pro Tools package also includes free applications and plug-ins from Avid and Avid Third Party developers. Once you have completed installing Pro Tools, you can install these separately.

Installers are located on your Pro Tools Installer disc in the Additional Files\3rd Party Content folder.

Pro Tools Demo Session

The Pro Tools Installer disc includes a demo session that you can use to verify that your system is working. The demo session for Pro Tools is named *Meant To Be*.

⚠️ Before installing the demo session to your audio drive, make sure your audio drive is configured as described in “Formatting Audio Drives” on page 42.

To install the demo session:

1. Insert the Pro Tools Installer disc into your DVD drive.
2. On the installer disc, in the Additional Files folder, locate and open the Pro Tools Demo Session Installer folder.
4. Follow the onscreen instructions to proceed with installation.
5. When prompted, select your audio drive as the install location and click Next to begin the install.
6. When installation is complete, click Finish.

The demo session can be opened by double-clicking the Meant To Be.ptf file found in the Pro Tools Demo Session folder.

Uninstalling Pro Tools

If you need to uninstall Pro Tools software from your computer, use the Uninstaller application.

To remove Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.
2 Go to C:\Program Files\Digidesign\Pro Tools\Pro Tools Utilities and double-click Uninstall Pro Tools Setup.exe.

3 Click Next to proceed with the uninstall.

4 Click Uninstall.

5 Enter your Administrator password and click OK.

6 Click Finish to restart your computer and complete the uninstallation.

---

**Optimizing a Windows System for Pro Tools**

To ensure optimum performance with Pro Tools, configure your computer before using Pro Tools hardware and software.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges, see your Windows documentation.

For the latest information about Windows system settings and for information about specific computers, visit the Avid website (www.avid.com).

---

**Required Optimizations**

To ensure optimum performance with Pro Tools, configure the following settings before using Pro Tools hardware and software.

⚠️ When you are finished changing Windows system settings, restart your computer.

---

**Disabling User Account Control**

To disable User Account Control (UAC):

1 Choose Start > Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click on Change User Account Control settings.

5 Set the slider to Never Notify.

6 Click OK.

---

**Configuring System Standby and Power Management**

When using Pro Tools, the Windows System Standby power scheme must be set to Always On. This prevents Pro Tools from stopping due to system resources powering down.

**To configure Windows Power Management:**

1 Choose Start > Control Panel.

2 Click on System and Security.

3 Click Power Options.

4 Click on the arrow to Show Additional Plans.

5 Select High Performance.

6 Click Change plan settings.

7 Click Change advanced power settings.

8 In the Power Options dialog, reveal Hard disk > Turn off hard disk after.

9 Click Setting option.

10 Select the value in the Setting (Minutes) field and press Backspace on your computer keyboard or scroll the value to Never, and click OK.

11 In the Edit Plan Settings window, click Save changes and close the window.
**Recommended Optimizations**

Pro Tools can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you do the following:

- Avoid running any unneeded programs at the same time as Pro Tools.
- Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
- Turn off any non-essential USB devices while running Pro Tools.

**Disabling System Startup Items**

The fewer items in use by your computer, the more resources are available for Pro Tools. Some startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:

- Portable media serial number (required for some applications that utilize a copy protection key)
- The Plug and Play service
- Event log
- Cryptographic services

**Optional Optimizations**

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

**Adjusting Processor Scheduling**

**To adjust Processor Scheduling performance:**

1. Right-click Computer and choose Properties.
2. Click Advanced system settings.
3. Under the Performance section, click the Settings button.
4. In the Performance Options window, click the Advanced tab.
5. Under the Processor Scheduling section, select the Background Services option.
6. Click OK to close the Performance Options window.
7. Click OK to close the System Properties window.

To Disable System Startup Items:

1. From the Start menu, type “msconfig” in Start Search and press Enter to open the System Configuration Utility.
2. Under the General tab, choose Selective Startup.
3. Deselect Load Startup Items and click OK.
4. Click Restart to restart the computer.
5. After restarting, the computer displays a System Configuration message. Check to see if Pro Tools performance has increased before you deselect the “Don’t show this message again” option. If performance has not changed, run “msconfig” and return your computer Startup Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling Startup items and non-essential processes individually.
After you have connected your system and installed Pro Tools software, you are ready to start up and configure your Pro Tools system.

### Starting Up or Shutting Down Your System

Whenever you start your system, turn on all of your system components in a specific order.

**Start up your Pro Tools system in this order:**

1. Make sure all your equipment (including your computer) is off.
2. Lower the volume of all output devices in your system (especially the main outputs to your speakers!).
3. Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.
4. Turn on any control surfaces (such as Command|8) or worksurfaces (such as D-Command).
5. Turn on any MIDI interfaces and devices, or synchronization peripherals.
6. With the volume of all output devices lowered, turn on your Pro Tools audio interfaces. Wait at least fifteen seconds for the audio interface to initialize and the status LEDs to stop flashing.
7. Turn on your computer.
8. Launch Pro Tools or any third-party audio or MIDI applications.
9. Bring the output levels up to a comfortable listening level.

**Shut down your Pro Tools system in this order:**

1. Quit Pro Tools and any other running applications.
2. Turn off or lower the volume of all output devices in your system.
3. Turn off your computer.
4. Turn off your Pro Tools audio interfaces.
5. Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.
6. Turn off any control surfaces or worksurfaces.
7. Turn off any external hard drives.

*To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).*
Configuring the Pro Tools Playback Engine

In the Playback Engine dialog, Pro Tools lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording. These system settings are available in the Playback Engine dialog (Setup > Playback Engine).

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) controls the size of the buffer used to handle host processing tasks such as Real-Time AudioSuite (RTAS) plug-ins. Typically, you will want the lowest possible H/W Buffer Size setting for monitoring while recording to reduce latency, and higher H/W Buffer Size settings for playback to accommodate host-processing with plug-ins and mixing.

- Lower Hardware Buffer Size settings are useful for improving latency issues in certain recording situations or for improving certain system performance problems.
- Higher Hardware Buffer Size settings are useful for sessions that are using more RTAS plug-ins for playback. These settings allow for more audio processing. They can also be useful to reduce errors on some machines that require a higher buffer size.

To change the Hardware Buffer Size:

1. Launch Pro Tools.
2. Choose Setup > Playback Engine.
3. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
4. Click OK.
Host Processors

With multiprocessor computers, the Host Processors setting lets you manage multi-processor support for RTAS processing.

Used in combination with the CPU Usage Limit setting, the Host Processors setting lets you control the way RTAS and other host-based processing tasks are carried out by the system. For example:

- For sessions with large numbers of RTAS plug-ins, you can allocate 2 or more processors to RTAS processing and set a high CPU Usage Limit.
- For sessions with few RTAS plug-ins, you can allocate fewer Host Processors to RTAS and set a low CPU Usage Limit settings to leave more host processing resources available for automation accuracy, screen response, and video.
- Depending on the importance of video and overall screen response, and on the density of automation being employed, try different combinations of Host Processors and CPU Usage Limit settings to achieve the best results.

For example, to improve screen response in a medium-sized session using a moderate number of RTAS plug-ins, try reducing the number of RTAS plug-ins, but keep the CPU Usage Limit set to the maximum (85%) on a single processor system.

To set the number of Host Processors:

2. From the RTAS Processors pop-up menu, select the number of available processors you want to allocate for RTAS plug-in processing. The number of processors available varies depending on how many processors are available on your computer:
   - Select 1 Processor to limit RTAS processing to one CPU in the system.
   - Select 2 Processors to enable load balancing across two available processors.
   - On systems running four or more processors, select the number of RTAS processors based on your processing needs.
3. Click OK.
**CPU Usage Limit**

The CPU Usage Limit setting controls the percentage of CPU resources allocated to Pro Tools host processing tasks. Used in combination with the Host Processors setting, the CPU Usage Limit setting lets you control the way Pro Tools tasks are carried out by the system.

- **Lower CPU Usage Limit** settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.
- **Higher CPU Usage Limit** settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more real-time plug-ins.

The maximum available CPU Usage Limit setting depends on the number of processors in your computer and on the number of processors you specify for host-processing tasks. This value can range from 85 percent for single-processor computers to 99 percent for multi-processor computers.

On multiprocessor computers, the maximum CPU Usage Limit is reduced when you use all your processors (as determined by the Host Processors setting). For example, on dual-processors, the limit will be 90%. On four-processor computers, the limit will be 95%.

⚠️ *Increasing the CPU Usage Limit may slow down screen responses on slower computers.*

**To change the CPU Usage Limit:**

2. From the CPU Usage Limit pop-up menu, select the percentage of host processing you want to allocate to Pro Tools.
3. Click OK.

**Host Engine (Error Suppression)**

The Host Engine option determines error reporting during playback and recording. This is especially useful when working with instrument plug-ins.

You should only enable error suppression if you are experiencing frequent errors that are interrupting your creative workflow. When error suppression is enabled, you can experience a degradation of audio quality. However, this may be acceptable in order to avoid interrupting playback and recording when working with instrument plug-ins. Be sure to disable error suppression when you need to ensure the highest possible audio quality, such as for a final mix.

**To enable error suppression:**

2. Select Ignore Errors During Playback/Record.
3. Click OK.

**Ignore Errors During Playback/Record**

When the Ignore Errors During Playback/Record option is enabled, Pro Tools continues to play and record even if the host processing requirements exceed the selected CPU Usage Limit. This can result in pops and clicks in the audio, but does not stop the transport.
Delay Compensation Engine

The Delay Compensation Engine setting determines the optimal setting for inherited plug-in and converter (DAC) latencies.

Within a session, you can choose to enable or disable Delay Compensation (Options > Delay Compensation). When enabled, Delay Compensation automatically manages delays resulting from host-based processing that occur on audio tracks, Auxiliary Inputs, or Master Faders because of plug-ins. With Delay Compensation enabled, Pro Tools maintains phase coherent time alignment between track outputs that have plug-ins with differing processing delays, tracks with different mixing paths, tracks that are split off and recombined within the mixer, and tracks with hardware inserts.

To maintain phase coherent time alignment, Pro Tools adds the exact amount of delay to each track necessary to make that particular track’s delay equal to the total system delay. The System Delay is shown in the Session Setup window (Setup > Session).

Delay Compensation should be enabled during mixing and playback for phase coherent time alignment between track outputs.

⚠️ With HD OMNI, Delay Compensation is not supported on Monitor output paths. Delay Compensation is only supported on physical output paths (those not assigned for the Monitor path).

When recording, in most cases Delay Compensation can be enabled. However, it is still recommended that you disable Delay Compensation for certain dubbing workflows (such as when recording to multiple audio tracks in series).

 exclaimed For more information on using Delay Compensation, see the Pro Tools Reference Guide.

To configure the Delay Compensation Engine:

2. From the Delay Compensation Engine pop-up menu, select a Delay Compensation setting.
3. Click OK.

Delay Compensation Settings

There are three settings in the Playback Engine dialog for dedicating resources for Delay Compensation:

None Allocates no resources for Delay Compensation.

Short Allocates minimum resources of Delay Compensation for each channel. This option is primarily included for compatibility reasons when exchanging sessions with Pro Tools|HD systems with limited DSP resources (such as a Pro Tool|HD 1 system).

Long Allocates maximum resources for Delay Compensation for each mixer channel. For sessions with a lot of plug-ins resulting in a large amount of delay, select this setting. With Pro Tools|HD Native, this is the recommended option.
**DAE Playback Buffer (Disk Buffer)**

The DAE Playback Buffer Size determines the amount of memory DAE allocates for disk buffers. In addition to levels, the DAE Playback Buffer Size shows values in milliseconds, which indicates the amount of audio buffered when the system reads from disk.

The optimum DAE Playback Buffer Size setting for most disk operations is 1500 msec (Level 2).

- DAE Playback Buffer Size settings lower than 1500 msec (Level 2) may improve playback and recording initiation speed. However, a lower setting may make it difficult to play or record tracks reliably with sessions containing a large number of tracks or a high density of edits, or with systems that have slower or heavily fragmented hard drives.

- DAE Playback Buffer Size settings higher than 1500 msec (Level 2) allow higher track count, higher density of edits in a session, or the use of slower hard drives. However, a higher setting may increase the time lag when starting playback or recording, or cause a longer audible time lag while editing during playback.

💡 Using a larger DAE Playback Buffer Size leaves less system memory for other tasks. The default setting of 1500 msec (Level 2) is recommended unless you are encountering –9073 (“Disk too slow or fragmented”) errors.

**To change the DAE Playback Buffer Size:**


2. From the DAE Playback Buffer pop-up menu, select a buffer size. Memory requirements for each setting are shown at the bottom of the Playback Engine dialog.

3. Click OK.

If Pro Tools needs more system memory for the DAE Playback Buffer, it will prompt you to restart your computer.

**Cache Size**

The Cache Size determines the amount of memory DAE allocates to pre-buffer audio for playback and looping when using Elastic Audio.

The optimum Cache Size setting for most sessions is Normal.

- A Cache Size setting of Minimum reduces the amount of system memory used for disk operations and frees up memory for other system tasks. However, using Elastic Audio features at this setting may decrease performance.

- A Cache Size setting of Large improves performance when using Elastic Audio features, but it also decreases the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Cache Size leaves less system memory for other tasks. The default setting of Normal is recommended unless you are encountering –9500 (“Cache too small”) errors.

**To change the Cache Size:**


2. From the Cache Size pop-up menu, select a disk cache size.

3. Click OK.
Plug-In Streaming Buffer Size
(Structure Plug-In Only)

This setting appears in the Playback Engine dialog only if the Structure sampler instrument plug-in is installed on your system (this applies to Structure LE and Structure Free as well). The Plug-In Streaming Buffer Size determines the amount of memory DAE allocates for streaming playback from disk with the Structure plug-in. This setting only affects playback if disk streaming is activated in Structure’s plug-in controls (see the Audio Plug-Ins Guide for more information).

The optimum Plug-In Streaming Buffer Size for most sessions is 250 ms (Level 2).

- Plug-In Streaming Buffer Size settings lower than 250 msec (Level 2) reduce the amount of system memory used for sample playback and frees up memory for other system tasks. However, reliability of sample playback may decrease.

- Plug-In Streaming Buffer Size settings higher than 250 msec (Level 2) improve the reliability of sample playback, but they also decrease the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Plug-In Streaming Buffer Size leaves less system memory for other tasks. The default setting of 250 ms (Level 2) is recommended unless you are experiencing problems with the reliability of streaming playback from disk.

To change the Plug-In Streaming Buffer Size:


2. From the Plug-In Streaming Buffer Size pop-up menu, select a buffer size.

3. Click OK.

Optimizing the Plug-In Streaming Buffer Size
(Structure Plug-In Only)

This option appears in the Playback Engine dialog only if the Structure sampler instrument plug-in is installed on your system. This option is useful when you are playing samples from the same drive that contains audio for the current session. When this option is selected, Pro Tools automatically optimizes the size of the Plug-In Streaming Buffer to facilitate disk access from both Pro Tools and Structure. The Plug-In Streaming Buffer Size pop-up menu is unavailable when this option is selected.

To set Pro Tools to automatically optimize the Plug-In Streaming Buffer Size:


2. Select the Optimize for Streaming Content on Audio Drives option.

3. Click OK.
Configuring the Pro Tools Hardware Setup

In the Hardware Setup dialog, Pro Tools lets you set the default sample rate (if no session is open) and clock source for your system, map Pro Tools input and output channels to physical analog and digital input and output ports (I/O) on audio interfaces, and provides access to a range of controls specific to each type of audio interface.

For more information about Hardware Setup, see the Pro Tools Reference Guide. For detailed information about configuring your audio interface, refer to its guide (such as the HD I/O Guide).

Default Sample Rate

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog.

To change the default Sample Rate for new sessions:

1. If a Pro Tools session is currently open, close it.

2. Choose Setup > Hardware.

3. From the Sample Rate pop-up menu, select the sample rate that you want.

4. Click OK.

Clock Source

The Pro Tools Hardware Setup dialog lets you set the Clock Source for the system.

Internal If you are recording an analog signal directly into Pro Tools, you will usually use the Pro Tools Internal clock source.

External If you are transferring material into Pro Tools from an external digital device, or if you utilize a common house clock signal, you will need to synchronize Pro Tools to that digital device or common signal. Depending on your audio interface, external options can include AES/EBU [Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, TDIF, ADAT, and Word Clock. For details, refer to the Pro Tools Reference Guide or to the guide for your specific audio interface.
To select the Clock Source:
1 Choose Setup > Hardware.
2 From the Clock Source pop-up menu, select the desired clock source.
3 Click OK.

⚠️ Your digital input device must be connected and powered on for Pro Tools to synchronize to it. If your input device is not powered on, leave the Clock Source set to Internal.

Configuring Audio Interfaces
HD OMNI supports up to 8 channels and HD I/O support up to 16 channels of simultaneous input and output in multiple I/O formats (including analog, AES/EBU, ADAT Optical, S/PDIF, and TDIF). MADI I/O supports up to 64 channels of I/O.

The Main page of the Hardware Setup dialog is where you define which physical inputs and outputs on your audio interface are routed to available input and output channels in Pro Tools. You can think of this window as a patchbay that lets you route any of the inputs or outputs on your Pro Tools audio interfaces to channel assignments in the Pro Tools mixer.

Additional pages are available to configure other controls for HD OMNI and HD I/O (such as setting operating levels). However, HD MADI provides only a single page for configuring HD MADI–specific options.

Identifying Audio Interfaces
If you have multiple audio interfaces of the same type connected to your system, you should confirm the identity of each interface before making audio connections. This ensures that you select the appropriate interface in the Peripherals list when you define its inputs and outputs in the Hardware Setup dialog.

To identify audio interfaces in your system:
1 Choose Setup > Hardware.
2 From the Peripherals list, select an audio interface connected to your system.
3 Make sure the Main page is shown.
4 Select the Identify option, located in the lower left corner of the Hardware Setup dialog. This illuminates all the LEDs on the front panel of the selected audio interface.
5 Make a note of which interface in your studio setup corresponds to the identified interface.
6 Repeat the above steps for each additional audio interface in your setup.

Your digital input device must be connected and powered on for Pro Tools to synchronize to it. If your input device is not powered on, leave the Clock Source set to Internal.

Identifying Audio Interfaces
If you have multiple audio interfaces of the same type connected to your system, you should confirm the identity of each interface before making audio connections. This ensures that you select the appropriate interface in the Peripherals list when you define its inputs and outputs in the Hardware Setup dialog.

To identify audio interfaces in your system:
1 Choose Setup > Hardware.
2 From the Peripherals list, select an audio interface connected to your system.
3 Make sure the Main page is shown.
4 Select the Identify option, located in the lower left corner of the Hardware Setup dialog. This illuminates all the LEDs on the front panel of the selected audio interface.
5 Make a note of which interface in your studio setup corresponds to the identified interface.
6 Repeat the above steps for each additional audio interface in your setup.

Your digital input device must be connected and powered on for Pro Tools to synchronize to it. If your input device is not powered on, leave the Clock Source set to Internal.

Identifying Audio Interfaces
If you have multiple audio interfaces of the same type connected to your system, you should confirm the identity of each interface before making audio connections. This ensures that you select the appropriate interface in the Peripherals list when you define its inputs and outputs in the Hardware Setup dialog.

To identify audio interfaces in your system:
1 Choose Setup > Hardware.
2 From the Peripherals list, select an audio interface connected to your system.
3 Make sure the Main page is shown.
4 Select the Identify option, located in the lower left corner of the Hardware Setup dialog. This illuminates all the LEDs on the front panel of the selected audio interface.
5 Make a note of which interface in your studio setup corresponds to the identified interface.
6 Repeat the above steps for each additional audio interface in your setup.

Your digital input device must be connected and powered on for Pro Tools to synchronize to it. If your input device is not powered on, leave the Clock Source set to Internal.

Identifying Audio Interfaces
If you have multiple audio interfaces of the same type connected to your system, you should confirm the identity of each interface before making audio connections. This ensures that you select the appropriate interface in the Peripherals list when you define its inputs and outputs in the Hardware Setup dialog.

To identify audio interfaces in your system:
1 Choose Setup > Hardware.
2 From the Peripherals list, select an audio interface connected to your system.
3 Make sure the Main page is shown.
4 Select the Identify option, located in the lower left corner of the Hardware Setup dialog. This illuminates all the LEDs on the front panel of the selected audio interface.
5 Make a note of which interface in your studio setup corresponds to the identified interface.
6 Repeat the above steps for each additional audio interface in your setup.
To configure Pro Tools|HD audio interfaces:

1. Choose Setup > Hardware.

2. From the Peripherals list, select the audio interface connected to the first card in your system. This will be the interface at the top of the list.

3. Click the Main tab.

[3] Press Command+Left or Right Arrow keys (Mac) or Control+Left or Right Arrow keys (Windows) to move though the different pages of the Hardware Setup dialog.

You can also press Command (Mac) or Control (Windows) and the number keys (1, 2, 3, 4, or 5) at the top of the QWERTY keyboard to select the corresponding page of the Hardware Setup. For example, press Command+4 (Mac) or Control+4 (Windows) to select the Monitor page for HD OMNI.

4. From the Clock Source pop-up menu, select the appropriate clock source for the interface.

In many cases, you will use Internal. The other choices are for resolving Pro Tools to external clock sources. Depending on your audio interface, Clock Source options can include: AES/EBU [Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, TDIF, ADAT, and Word Clock (optional Word Clock rates are available when operating at higher sample rates).

5. If you want to send clock output to other devices attached to the audio interface, select the appropriate output from the Ext. Clock Output pop-up menu.

6. Select which digital I/O port on your audio interface enclosure is active by selecting an option under Digital Format. Depending on the type of interfaces in your system, choices include AES/EBU, S/PDIF, and Optical (S/PDIF). Selecting Optical (S/PDIF) resets the Optical I/O port (which is, by default, eight channels of ADAT Optical I/O) to two channels of S/PDIF Optical I/O.

7. For S/PDIF compatibility with Tascam DA-30 DAT recorders, select the Tascam option under S/PDIF Output Format.

8. From the Input and Output channel pop-up menus, select the physical ports (such as Analog 1–2 or Optical 1–2), that will be routed to the corresponding Pro Tools input and output channels (such as Ch 1–2, Ch 3–4), listed on the left side of the Main page.

Inputs and outputs of similar format are differentiated in the input and output channel pop-up menus. For example, the AES/EBU inputs and outputs in the HD I/O enclosure are listed as AES/EBU [Encl], while the AES/EBU inputs and outputs on the factory-installed Digital I/O card are listed (in pairs) as AES/EBU 1–2, AES/EBU 3–4, AES/EBU 5–6, and AES/EBU 7–8. For HD I/Os equipped with the optional Digital I/O Card, the additional AES/EBU I/O ports on the optional card are listed as AES/EBU 9–10, AES/EBU 11–12, AES/EBU 13–14, and AES/EBU 15–16.

💡 Refer to your audio interface guide for specific configuration details and restrictions.

9. Configure any specific controls for your audio interface.

10. For additional audio interfaces, select the interface in the Peripherals list, and repeat the above steps.
Configuring I/O Setup

The I/O Setup dialog provides a graphical representation of the signal routing for internal mix bussing, output bussing, hardware inserts, and the physical inputs and outputs for each connected audio interface in the form of a cross-point matrix. I/O Setup controls let you route Pro Tools input and output channels to physical ports on your audio interfaces. The controls for assigning physical inputs and outputs in the I/O Setup Input and Output pages mirror the routing controls in the Main page of the Hardware Setup dialog for each audio interface—changes made to audio path routing in one dialog are always reflected in the other.

The I/O Setup dialog lets you label and map Pro Tools input, output, insert, and bus signal paths. The I/O Setup dialog also provides important audition, meter, and surround monitoring settings.


Opening the I/O Setup Dialog

The I/O Setup dialog can be opened and configured whether or not a Pro Tools session is open.

To open the I/O Setup dialog:

1. Make sure your audio interfaces are enabled and configured properly in the Hardware Setup dialog. See “Configuring Audio Interfaces” on page 35.
2. Choose Setup > I/O.

Closing the I/O Setup Dialog

To close the I/O Setup dialog and save changes:

- Click OK.

When you click OK, Pro Tools checks several settings for routing validity (to prevent feedback loops).

To close the I/O Setup dialog without saving changes:

- Click Cancel.
**I/O Settings Pages**

The I/O Setup dialog provides tabs to open pages for configuring the following I/O Settings:

**Input** Configure input signal path names, formats, and source channels (analog or digital). Multichannel input paths (stereo or greater) can have any number of sub-paths. You can have overlapping Input signal paths. Input names, channel widths, and physical input mappings are saved with the system.

**Output** Configure output signal path names and formats. You can have overlapping Output paths. Output names, channel widths, and physical output mappings are saved with the system.

**Insert** Configure insert signal path names, formats, and destinations (audio interface channels). You can have overlapping Insert paths. Insert names, channel widths, and physical input and output mappings are saved with the system.

**Bus** Configure internal and output bus signal path names and formats, and map output busses to output paths (defined on the Output page). Multichannel busses (stereo or greater) can have any number of sub-paths. Output bus and internal mix bus names and channel widths are saved with the session. Output bus paths to output channel mappings are automatically generated depending on the defined session output bus paths and the available system output channel paths.

**Mic Preamps** Map PRE outputs to an audio interface’s inputs to establish communication between Pro Tools and PRE. PRE channel mappings are saved with the system.

**H/W Insert Delay** Set the amount of Delay Compensation (in milliseconds) for each external device. These times will be used by the Delay Compensation Engine to time align input paths when the hardware insert is in use and Delay Compensation is enabled. The H/W Insert Delay settings are saved with the system.

**To open any specific I/O Settings page:**
- Click the corresponding tab at the top of the I/O Setup dialog.

**Press Command+Left or Right Arrow keys (Mac) or Control+Left or Right Arrow keys (Windows) to move through the different pages of the I/O Setup dialog.**

**It is recommended that if you choose to customize your I/O Setup, configure the system-specific options first: Input, Output, Insert, Mic Preamps, and H/W Insert Delay. Once you have configured your system, you shouldn’t need to change it unless you add or remove hardware (such as audio interfaces) from your system.**

**Default I/O Settings**

Pro Tools comes with default I/O Setup settings to get you started. You should only need to open the I/O Setup if you want to remap or rename the default I/O paths or if you change your system hardware (for example, adding an expansion card to HD I/O). Also, after customizing the I/O Setup, you can always return to the default settings for an I/O Settings page by clicking the Default button.
Renaming I/O Paths

Pro Tools has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename or remap the default I/O paths.

To rename I/O paths in I/O Setup:
1. Choose Setup > I/O.
2. Click the Input, Output, Insert, or Bus tab to display the corresponding connections.
3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Enter.
4. Click OK.

Low Latency Monitoring

Pro Tools|HD Native systems can use the Low Latency Monitoring option to record with an extremely small amount of monitoring latency, to as many tracks as the system supports. Only tracks with input from an audio interface (not an internal mix bus) use Low Latency Monitoring.

To use Low Latency Monitoring:
1. From the Output Path selector, assign each track to the selected Low Latency Monitoring Path (as set in the I/O Setup Output page). Only tracks assigned to these outputs use Low Latency Monitoring.
2. Record enable audio tracks by clicking their Record Enable buttons.
3. Select Options > Low Latency Monitoring.
4. When Low Latency Monitoring is enabled, any plug-ins and sends assigned to record-enabled tracks (routed to the selected Low Latency Monitoring Path) are automatically bypassed, and must remain bypassed. Also, these tracks do not register on meters for Master Faders.

Configuring Low Latency Monitoring in the I/O Setup

The Output page of the I/O Setup lets you enable (or disable) Low Latency Monitoring. It also lets you specify any available Output path for Low Latency Monitoring. The Output path for Low Latency Monitoring can be of any channel width (from Mono to 7.1). Low Latency Monitoring uses Outputs 1–2 by default.

To configure Low Latency Monitoring in the I/O Setup:
1. Open the I/O Setup dialog (Setup > I/O).
2. Click the Output tab.
3. Enable the Low Latency Monitoring option.
4. From the Low Latency Monitoring pop-up menu, select the Output path you want to use for Low Latency Monitoring.
5. Click OK to save your changes and close the I/O Setup.
Low Latency Monitoring and Bounce To Disk

With Low Latency Monitoring enabled, only audio tracks are included with the Bounce to Disk command—Auxiliary Input and Instrument tracks are ignored. To include Auxiliary Input and Instrument tracks, disable Low Latency Monitoring before using Bounce to Disk.

⚠️ External input cannot be recorded during a Bounce to Disk. To include external input in your bounce, it must be recorded to new audio tracks before using Bounce to Disk.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Bombich Carbon Copy Cloner or Time Machine (Mac) or Acronis True Image or Norton Ghost (Windows). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools, do one of the following:

- On Mac, configure your MIDI setup with Audio MIDI Setup. See Appendix C, “Configuring MIDI Setup (Mac OS X Only)” for details.

  – or –

It is recommended that you start with a newly formatted external or secondary internal audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

Hard drive performance depends on factors including system configuration, number of tracks, session sample rate, density of edits, and the use of crossfades and other processes such as Beat Detective in a session.

For complete hard drive requirements, visit our website (www.avid.com).

⚠️ Always back up any important data on your drive before formatting it, as it will erase all data on the drive.

Avoid Recording to the System Drive

Recording to your system drive is allowed, but not recommended. Recording and playback on a system drive may result in lower track counts and fewer plug-ins.

💡 For optimum performance, you may want to designate your system drive as a Playback or Transfer only volume in DigiBase. For more information, see the Pro Tools Reference Guide.

### Supported Drive Formats and Drive Types

#### Drive Formats

**Mac** Mac systems should use drives formatted with HFS or HFS+ file system only.

⚠️ HFS drives are supported as Transfer drives only.

**Windows** Windows systems should use drives formatted as NTFS only.

Windows systems can also support Mac drives formatted using the HFS+ system (also commonly referred to as Mac OS Extended). Refer to the Pro Tools Reference Guide for more information.
FireWire Hard Drives

Avid recommends qualified FireWire drives for all systems. On systems without Fire Wire ports, a qualified FireWire host adapter is recommended.

For complete information on track count and the supported number and configuration of FireWire drives, visit our website (www.avid.com).

SAS, SATA, ATA, and IDE Hard Drives

Qualified SAS, SATA, ATA, and IDE hard drives may be used as dedicated audio drives.

For complete information on track count with supported hard drives, visit our website (www.avid.com).

Avid Unity

Pro Tools supports Avid Unity network storage systems. For more information, see the Pro Tools ISIS Guide.

Formatting Audio Drives

Formatting Mac Audio Drives

For optimum performance, audio drives should be formatted as Mac OS Extended (Journaled).

To format an audio drive:

1. Launch the Disk Utility application, located in Applications/Utilities.

2. Click the Erase tab.

3. Select the drive you want to initialize in the column on the left side of the window.

4. Choose Mac OS Extended (Journaled).

   Do not choose the “Case-Sensitive” format option. Pro Tools will not operate properly with case-sensitive formatted drives.

5. Type a name for the new volume.

6. If you plan to connect the drive to a Mac OS 9 computer, select Install Mac OS 9 Drivers.

7. Click Erase.

The drive appears on the Desktop with the new volume name.
**Formatting Windows Audio Drives**

For optimal performance, audio drives should be formatted as NTFS.

⚠️ *Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.*

**To format an audio drive:**

1. Right-click Computer and choose Manage.
2. Under Storage, select Disk Management.
3. If the volume is “Healthy,” do the following:
   - In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
   - In the Format window, name the volume.
   - Choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select “Perform a quick format.”
   - Make sure “Enable file and folder compression” is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

4. If the volume is “Unallocated,” do the following:
   - In the Disk Management window, right-click the hard drive you will use for audio and choose New Simple Volume.
   - In the New Simple Volume Wizard window, click Next.
   - Follow the on-screen instructions to select a partition size and other partition settings.
   - When prompted, choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select “Perform a quick format.”
   - Make sure “Enable file and folder compression” is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

💡 *Avid recommends using Primary partitions, instead of Extended partitions.*

---

**Disk Management window**

**Format window**

*Healthy volumes are volumes that have previously been partitioned and formatted.*

- In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
- In the Format window, name the volume.
Partitioning Drives

Partitioning creates a logical volume or volumes on a physical drive, almost as if you were creating virtual hard drives. Partitions can then be formatted with the appropriate file system (NTFS for Windows, HFS+ for Mac).

⚠️ The NTFS file system allows drives to be seen as whole volumes. Single Pro Tools audio files cannot exceed 3.4 GB in size.

⚠️ Mac OS allows drives larger than 4096 MB to be seen as whole volumes. Drives must be initialized with a disk utility that recognizes the 2 terabyte limit. Single Pro Tools audio files cannot exceed 3.4 GB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger partitions, but this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

⚠️ Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.

Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), you can limit fragmentation by backing up your important files to another disk, erasing the files from the original hard disk, then copying the files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain system performance.

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to play back the data. Unfortunately, your computer can’t always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontiguous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in performance errors.

💡 On Windows, to avoid fragmentation, format drives with higher cluster sizes (such as 32K).
Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard drive utility to find and repair any problems before optimizing data or re-initializing your drives. If there is any damage to your hard drive's directories prior to optimizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive:
1. Right-click Computer and choose Manage.
2. In the Disk Defragmenter window, choose the drive you want to defragment
3. Click the Defragment button and follow the on-screen instructions.

When defragmenting is complete, close the Computer Management window.

Using Mac Drives on Windows Systems

Pro Tools for Windows lets you record and play back sessions directly from a Mac-formatted (HFS+) drive connected to a Windows system. This functionality requires that all Mac session and audio files be stored on Mac-formatted drives.

During Pro Tools installation, make sure to select the Mac HFS+ Disk Support option. This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks.

For information on sharing sessions between Mac and Windows systems, see the Pro Tools Reference Guide.

Formatting and Maintaining HFS+ Drives

To format and partition any drives as HFS+, connect the drives to a Mac computer and use the Apple OS X Disk Utility.

Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 15 MB per minute.
Table 2 lists the required disk space for certain track numbers and track lengths, to help you estimate your hard disk usage.

**Table 2. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)**

<table>
<thead>
<tr>
<th>Number of Tracks and Length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>7 GB</td>
<td>7.8 GB</td>
<td>10.5 GB</td>
<td>11.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.4 GB</td>
</tr>
</tbody>
</table>
Configuring CoreAudio (Mac OS X Only)

CoreAudio Driver Capabilities

The CoreAudio Driver is a multi-client, multi-channel sound driver that lets CoreAudio–compatible applications record and play back through Pro Tools hardware.

Full-duplex recording and playback of 24-bit audio is supported at sample rates up to 96 kHz, depending on your Pro Tools hardware and CoreAudio client application.

The Pro Tools CoreAudio Driver provides up to 64 channels of I/O with Pro Tools|HD Native systems.

💡 Visit www.avid.com for the latest CoreAudio drivers for Pro Tools hardware, as well as current known issues.

Limitations of the CoreAudio Driver

The CoreAudio Driver has the following limitations:

- The CoreAudio Driver cannot be used to preview sound files from the Mac Finder. When a sound file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets you audition the sound file. The sound will always play back through the Mac’s built-in audio controller (through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application will launch, and can use the CoreAudio Driver for playback.

- The CoreAudio Driver cannot be used for playback of Mac System Sounds.

Installing the CoreAudio Driver

The CoreAudio Driver is installed by default when you install Pro Tools.

The CoreAudio Driver can also be installed as a standalone driver on Mac systems that do not have Pro Tools software installed. The installer for the standalone CoreAudio Driver is available from our website (www.avid.com).

⚠️ If you uninstall Pro Tools, the CoreAudio Driver is automatically uninstalled at that time.
CoreAudio Manager

You can configure the CoreAudio Driver using CoreAudio Manager, or from within most third-party CoreAudio-compatible client applications (such as BIAS Peak or Logic). Refer to the manufacturer’s documentation for more information.

Some applications (such as Apple’s iTunes or QuickTime Player), also require that you configure either the Apple Sound Preferences or Apple Audio MIDI Setup (AMS) to use the CoreAudio Driver.

The CoreAudio Manager is configured to auto-hide when first launched. To bring it to the foreground, click on its icon in the dock.

The CoreAudio Manager is not used by Pro Tools. It is only used by other CoreAudio applications.

Accessing the CoreAudio Manager

The CoreAudio Manager application launches automatically when the first client application accesses the CoreAudio Driver.

CoreAudio Manager cannot be accessed under the following circumstances:

- When Pro Tools is running
- When another application is using Direct IO

💡 To ensure proper playback with the CoreAudio Driver, launch the CoreAudio Manager first, making sure that its status is “Connected.”

Preventing an Application from Accessing CoreAudio Driver

You can prevent an application from accessing the CoreAudio Driver by holding down the Shift key just before the application would access the CoreAudio Driver, typically during launch of the application. Certain applications (such as Apple Mail and iChat), do not access the CoreAudio application until they first play a sound, so you will need to hold down the Shift key just prior to sound playback in order to prevent the use of Pro Tools hardware for playback.

Using the CoreAudio Manager

Use CoreAudio Manager to change the CoreAudio Buffer Size setting, access the Hardware Setup dialog for your Pro Tools hardware and control volume and mute for the CoreAudio Driver. CoreAudio Manager also identifies your Pro Tools hardware, the supported number of Input and Output Channels and the number of attached clients (applications).
Buffer Size

You may select from the following buffer sizes (depending on your Pro Tools hardware):

- 64 samples
- 128 samples
- 256 samples
- 512 samples
- 1024 samples
- 2048 samples

Changing the Buffer Size for the CoreAudio Driver does not affect the H/W Buffer Size setting in the Pro Tools Playback Engine dialog.

To configure CoreAudio Hardware Buffer Size:

1. Double-click the CoreAudio Manager file (located in /Applications/Digidesign/).

2. From the Buffer Size pop-up menu, select the desired CoreAudio buffer size (in samples). Generally, smaller buffer sizes are preferable. However, if you experience any problems with performance (such as clicks and pops during recording or playback), try increasing the CoreAudio Buffer Size setting. You can also change the buffer size from within the client application if it is the only client attached to the CoreAudio Driver. Once two or more clients are active, you will not be able to change the sample rate or the buffer size.

HW Setup Button

The HW Setup button opens the Hardware Setup dialog for your Pro Tools hardware. The HW Setup button is only available when no clients are using the CoreAudio Driver.

To configure CoreAudio HW Setup:

1. Quit any CoreAudio client applications.

2. Double-click the Digi CoreAudio Manager file (located in /Applications/Digidesign/).

3. Click the HW Setup button to open the Hardware Setup dialog.

4. Configure the Hardware Setup dialog for your Pro Tools hardware. If you have more than one audio interface connected to a Pro Tools|HD system, be sure to select and configure only the primary audio interface connected to the HD Core card.

For more information on the Hardware Setup dialog, refer to the Pro Tools Reference Guide.

5. When you are finished, click OK to close the Hardware Setup dialog.

Prefs Button

The Prefs button opens the CoreAudio Manager Preferences dialog for the Manager application. There are several options available for control and configuration of the Manager application. When finished setting these options, click OK to close the CoreAudio Manager Preferences windows.

CoreAudio Manager Preferences

Hide Manager if Auto-Launched by Client Enable this option to hide the Manager panel after the first client application accesses the CoreAudio Driver. To open the Manager panel, click on the CoreAudio Manager application icon in the Dock.
Auto-Quit Manager when Last Client Quits  Enable this option to make the Manager application quit when there are no longer any clients using the CoreAudio Driver.

Use C|24 Stereo Routing (L/R to 1/3)  When using C|24, enable this option to configure the CoreAudio Driver to output through the C|24 standard stereo routing (outputs 1 and 3).

Use XMON Stereo Routing (L/R to 1/5)  When using D-Control or D-Command, enable this option to configure the CoreAudio Driver to output through the D-Control or D-Command standard stereo routing (outputs 1 and 5).

Mirror Analog Outs 1 & 2 to Digital Outs (003, 003 Rack, 003 Rack+, Digi 002, or Digi 002 Rack Only)  When using 003, 003 Rack, 003 Rack+, Digi 002, or Digi 002 Rack, enable this option to mirror the main outputs through the digital outputs that are selected in the Hardware Setup dialog. (This option is grayed out for Pro Tools|HD systems.)

Connect Button

The Connect button is available when the CoreAudio Manager is launched and cannot connect with the Pro Tools hardware (such as when Pro Tools is launched and the hardware is disconnected or disabled). Before trying to connect, make sure to quit Pro Tools and make sure that your hardware is connected and turned on. You can then click on the Connect button to acquire the hardware.

⚠️ If any application is launched prior to pressing the Connect button and you want that application to use the CoreAudio Driver for playback, you will need to quit and relaunch the application for it to connect properly to the CoreAudio Manager.

Quit Button

Use the Quit button to quit the CoreAudio Manager. Be sure to quit any client applications before using the Quit button in the Manager. If any applications are currently attached to the Manager application when quitting, you may get an error message indicating that the Pro Tools hardware is no longer available. You may have to change the application’s preferences to use different hardware for playback or possibly quit and relaunch the application for proper playback to be resumed.

Configuring a Pro Tools|HD Audio Interface for Third-Party Applications

When using a Pro Tools|HD Native with an application other than Pro Tools (such as Apple GarageBand), you can configure hardware settings through the audio preference settings available in that application.

To configure hardware settings through a client application (such as Apple GarageBand):

1. Choose CoreAudio for Audio Output and Audio Input.

2. Select a buffer size for your system by selecting an Optimize For option (Maximum/Large buffer size or Minimum/Small buffer size).

Refer to the documentation for your third-party application to learn more about how these options affect that application.

💡 Changing the Buffer Size for the CoreAudio Driver does not affect the H/W Buffer Size settings in the Pro Tools Playback Engine dialog.
Configuring the Apple Sound Preferences or Apple Audio MIDI Setup

(Required for Using Qualified Pro Tools System Interface with Apple iTunes or QuickTime Player)

To use your Pro Tools hardware with certain CoreAudio-compatible playback applications (such as Apple iTunes or QuickTime Player), you will need to configure either Sound Preferences or Audio MIDI Setup in addition to CoreAudio Manager. However, for most CoreAudio-compatible client applications (such as BIAS Peak or Ableton Live) this is unnecessary, because you can configure the CoreAudio Buffer Size setting and input and output channels from within the client application.

Apple Sound Preferences

To configure the Apple Sound Preferences:

1. Launch System Preferences (Apple menu > System Preferences).
2. Click Sound.
3. Click Output and select Pro Tools HD Native as the device for sound output.

4. Click Input and select Pro Tools HD Native as the device for sound input.

5. Quit System Preferences.
Apple Audio MIDI Setup

To configure the Apple Audio MIDI Setup:

1. Launch Audio MIDI Setup (located in Home/Applications/Utilities).

2. In the Audio Devices window, click the Input tab.

3. From the Audio Devices list on the left, select Pro Tools|HD Native.

4. In the Audio Devices window, click the Output tab.

5. From the Audio Devices list on the left, select Pro Tools|HD Native.

⚠️ Leave System Output set to Built-in Audio. The CoreAudio Driver cannot be used for system sounds.

6. In the Audio Input or Audio Output page, select the Format (sample rate). Note that the input sample rate and output rate are linked.

💡 When Properties For Pro Tools HW is selected, you can click the Configure Device button to open System Preferences, where the CoreAudio Manager can be accessed.

警告 For information on configuring MIDI devices in AMS, see the Setup Guide for your Pro Tools system.

7. Choose Audio MIDI Setup > Quit Audio MIDI Setup.
Configuring MIDI Setup (Mac OS X Only)

MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

⚠️ To ensure optimum performance, do not change the AMS configuration while Pro Tools is playing back. Stop the Pro Tools transport before launching AMS.

To configure your MIDI studio in AMS:

1. Do one of the following:
   - Launch Audio MIDI Setup (located in Applications/Utilities).
   - or –
   - In Pro Tools, choose Setup > MIDI > MIDI Studio.

2. Choose Window > MIDI Studio. AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

💡 To remove a connection, select the cable and press Delete.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1 Select the external device icon and click Show Info (or double-click the new device icon).

External Device Icon

2 Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

Naming a new MIDI device

💡 For Manufacturer and Model names, AMS refers to one or more files with the suffix “.middev” in the directory Root/Library/Audio/MIDI Devices. Pro Tools installs a file that contains information for many commercially available MIDI devices, named “Digidesign Device List.middev.” If the Manufacturer or Model names for any of your external MIDI devices is not available in the AMS Manufacturer and Model pop-up menus, you can add them by editing the .middev file in any text editor (such as TextEdit).
3 Click the More Information arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

5 Select a device image and click Apply.

6 Close the AMS window to quit the AMS application.

The device names you enter appear as MIDI input and output choices in Pro Tools.
MIDI Patch Name Support

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for you external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in /Library/Audio/MIDI Patch Names/Digidesign.

To import MIDI patch names into Pro Tools:

1. Verify the MIDI Device name in the Audio MIDI Setup window (see “MIDI Setup” on page 53).
2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.
3. Click the Instrument or MIDI track Patch Select button.
4. In the Patch Select dialog, click Change.
5. In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.
6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:

- In the Patch Select dialog, click Clear, and the click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
appendix d

Configuring ASIO (Windows Only)

ASIO Driver Capabilities

The ASIO Driver is a single-client, multichannel sound driver that allows third-party audio programs that support the ASIO Driver standard to record and play back through qualified Pro Tools audio interfaces.

Full-duplex playback of 24- and 16-bit audio are supported at sample rates up to 96 kHz, depending on your Pro Tools hardware and ASIO-client program used (such as Cubase or Reason).

The ASIO Driver provides up to 64 channels of input and output with Pro Tools|HD Native systems.

💡 Visit www.avid.com for the latest ASIO drivers for Pro Tools hardware, as well as current known issues.

Limitations of the ASIO Driver

The ASIO Driver cannot be used with multiple applications at the same time. Only one application at a time can use the ASIO Driver. Be sure to disable the Windows system sounds. It is also recommended that you use a separate sound card for games or other general work.

Installing the ASIO Driver

The ASIO Driver is installed by default when you install Pro Tools.

The ASIO Driver can also be installed as a stand-alone driver on Windows systems that do not have Pro Tools software installed. The installer for the standalone ASIO Driver is available from our website (www.avid.com).

⚠️ If you uninstall Pro Tools, the ASIO Driver is automatically uninstalled at that time.

ASIO Driver Control Panel

Configuring ASIO Driver settings can be done using the ASIO Control Panel, which is accessed within some third-party ASIO-compatible client applications.

Accessing the ASIO Driver Control Panel

To access the ASIO Driver Control Panel from a third-party application:

- Refer to your ASIO-client program’s documentation.
The ASIO Driver Control Panel cannot be accessed under the following circumstances:

- When Pro Tools is running.
- When playing or recording in an audio program that does not support the ASIO Driver.
- When using a third-party audio program that has an option to keep the ASIO Driver open even when you are not playing or recording. (You must close the audio program before you can open the ASIO Driver Control Panel.)

**Example with Ableton Live**

For example, with Ableton Live, click the Hardware Setup button in the Audio Preferences.

**Using the ASIO Driver Control Panel**

From the ASIO Driver Control Panel, you can change the Buffer Size setting or access the Hardware Setup dialog for your Pro Tools hardware.

**Buffer Size**

You may select from the following buffer sizes (depending on your Pro Tools hardware):

- 128 samples
- 256 samples
- 512 samples
- 1024 samples
- 2048 samples

In some ASIO-compatible audio programs, performing various tasks will interrupt the ASIO Driver and may result in clicks and pops in audio playback or recording. Choosing medium or large buffers (such as 256, 512, or 1024) can help alleviate this problem.

Changing the Buffer Size setting for the ASIO Driver does not affect the H/W Buffer Size settings in the Pro Tools Playback Engine dialog.

**Device**

The Device setting is always set to your installed Pro Tools hardware.

**Advanced Button**

The Advanced button opens the Hardware Setup dialog for the Pro Tools hardware that you are using.

For more information on the Hardware Setup dialog, refer to the Pro Tools Reference Guide or the User Guide that came with your Pro Tools system.
Configuring MIDI Studio Setup (Windows Only)

MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.
Interface Controls

**Create** Adds a new instrument to the Instrument Name list.

**Delete** Deletes the instrument or instruments selected in the Instrument Name list.

**Import** Imports an existing MIDI Studio Setup file.

**Export** Exports the current MIDI Studio Setup file.

**Show Duplicate Emulated Ports** When this option is selected and you are using a MIDI interface that supports timestamping (such as MIDI I/O), in addition to the MIDI ports on Mbox 2, the MIDI Studio setup window shows both the DirectMusic time-stamped output ports, and non-stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load or unload their drivers unless you quit and re-launch Pro Tools. Check the documentation that came with your MIDI interface for more information.

Instrument List

The Instrument list contains all the currently defined instruments. Selecting an instrument in the list displays that instrument’s properties in the Properties section of the window.

Properties Section

The Properties section lets you edit information for new instruments, or instrument currently selected in the Instrument list.

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument Name: ProTools</td>
</tr>
<tr>
<td>Manufacturer: E-mu</td>
</tr>
<tr>
<td>Model: EMU</td>
</tr>
<tr>
<td>Input Port: Digidesign MIDI I/O: Port 1</td>
</tr>
<tr>
<td>Output Port: Digidesign MIDI I/O: Port 1</td>
</tr>
<tr>
<td>Send Channels: 1 2 3 4 5 6 7 8</td>
</tr>
<tr>
<td>Receive Channels: 1 2 3 4 5 6 7 8</td>
</tr>
</tbody>
</table>

MIDI Studio Setup Properties section

When a previously defined instrument is selected in the Instrument list, the Properties section changes to reflect the properties of the selected instrument.

To define an instrument with MIDI Studio Setup:

1. Choose Setup > MIDI > MIDI Studio.
2. Click Create.
3. In the Instrument Name field, type the name of your instrument, and press Enter.

💡 If you do not enter an instrument name, the Instrument Name field will automatically inherit information from the Manufacturer and Model pop-up menu.

4. Set a manufacturer and model for the new device from the corresponding pop-up menus. If the Manufacturer and Model pop-up menus do not provide a name for your particular device, choose None.

5. From the Input pop-up menu, choose the input port on your MIDI interface that is connected to the MIDI Out of your instrument.
6 From the Output pop-up menu, choose the output port on your MIDI interface that is connected to the MIDI In of your instrument.

7 Enable the appropriate MIDI channels (1–16) for the Send Channels and Receive Channels options (These determine which channels send and receive MIDI.)

**Instrument Name**

The Instrument Name field shows the user-definable instrument name for the currently selected instrument.

**Manufacturer**

The Manufacturer pop-up menu provides a list of MIDI equipment manufacturers. This list is derived from the XML-based MIDI device files.

*For more information, see “MIDI Patch Name Support” on page 61.*

**Model**

The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files.

*For more information, see “MIDI Patch Name Support” on page 61.*

**Input Port**

The Input Port pop-up menu displays a list of available MIDI interface input ports. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field.

*If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input Selector.*

**Output Port**

The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

*If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output Selector.*

**Send Channels**

The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

**Receive Channels**

The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

**MIDI Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.

*To import MIDI patch names into Pro Tools:*

1. Verify the MIDI Device name in the MIDI Studio Setup window (see “MIDI Studio Setup” on page 59).

2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.
3 Click the Instrument or MIDI track Patch Select button.

4 In the Patch Select dialog, click Change.

5 In the Open dialog, navigate to Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6 Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:
- In the Patch Select dialog, click Clear, and then click Done.

💡 MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
appendix f

System Delays in Mixing

This appendix provides an overview of system mixer delays in Pro Tools|HD Native systems, and explains how you can compensate for these delays for phase coherent time alignment of audio in complex or critical mixing situations.

For detailed information on using Automatic Delay Compensation, see the Pro Tools Reference Guide.

Introduction to System Delay

In all digital systems, digital signal processing (DSP) causes signal delays of varying amounts. These delays can vary from as short as several microseconds to as long as several milliseconds, depending on the type of processing or routing being performed. With Pro Tools|HD Native systems, these delays result from host-based processing tasks.

Do not confuse signal processing-induced delays with monitoring latency or time domain effects processing (such as delay, echo, reverb, and other desirable delay effects).

In addition to delay incurred by the host buffer, each plug-in, hardware insert, and mixer assignment on a track delays that track by an amount equal to the total of all system delay factors. (For more information on these delays, see “Delay Factors” on page 64.)

In some cases, signal processing delays matter only if you use a real-time plug-in on one channel of a stereo or multichannel signal but not the others. This imparts an unequal amount of delay to the signals on that channel, which subsequently may cause undesirable cancellation of certain frequencies (phase cancellation).

Audible symptoms of phase issues include comb-filtering and loss of high frequencies.

In simple terms, system delay can cause audio to arrive at the main output (or a submix output) at different times. To maintain time alignment, you can compensate for these delays.

When to Compensate

You may only really need to compensate for delays between tracks where phase coherency must be maintained (as with instruments recorded with multiple microphones or stereo pairs). If you are working with mono signals, and the accumulated delays are small (just a few samples, for example), you probably do not need to worry about compensating for delays.

However, larger sessions with higher track and voice counts, many plug-ins, and/or complex mixer routing can benefit when system delays are compensated to maintain phase coherent time alignment.
In any session, if you want to maintain absolute time alignment across all tracks you should always compensate for signal processing delays.

**Using Delay Compensation**

Pro Tools provides automatic Delay Compensation for managing delays from plug-in and hardware inserts, and mixer routing (bussing and sends). With Delay Compensation enabled, Pro Tools maintains phase coherent time alignment between tracks that have plug-ins with differing DSP delays, tracks with different mixing paths, tracks that are split off and recombined within the mixer, and tracks with hardware inserts.

To maintain phase coherent time alignment, Delay Compensation should always be enabled during playback and mixing. Delay Compensation should also be used in most recording situations.

⚠️ *With HD OMNI, Delay Compensation is not supported on Monitor output paths. Delay Compensation is only supported on physical output paths (those not assigned for the Monitor path).*

---

**Enabling Delay Compensation**

**To enable Delay Compensation:**

- Select Options > Delay Compensation.

When Delay Compensation is enabled, the Delay Compensation status indicator in the Edit Window Toolbar is displayed.

---

**Delay Factors**

With Pro Tools, delay is incurred when you perform the following processes:

- Real-time processing with plug-in inserts.
- Mixing and routing with hardware I/O (sends or inserts).

⚠️ *For information on the delay amounts for plug-ins, refer to the Audio Plug-Ins Guide.*
Appendix G

Troubleshooting

Backing Up Your Work

It is highly recommended that you back up your work on a regular basis, and especially before making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. There are a variety of media that are suited to back up projects of various sizes, from automated tape backup systems to high-capacity optical drives, to CD/DVD burners.

The best way to back up an entire session is to use the Save Copy In command. This command lets you save the session file and all of its associated files to a new location.

💡 You can also use the Auto Save Backup feature (in the Operation Preferences page) to have Pro Tools automatically save backups of the session file while you work.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.
Common Issues

Pro Tools Won’t Launch

Problem
When you double-click the Pro Tools application or a Pro Tools session file, Pro Tools doesn’t launch, or displays an error message.

Possible Solutions
✦ Check to be sure your computer has the required amount of RAM to launch Pro Tools. Refer to our website (www.avid.com).
✦ Try a complete restart. Turn off your audio interfaces, computer peripherals and your computer, and then turn them on again in the proper sequence.
✦ If you tried to launch Pro Tools by double-clicking a Pro Tools session file, do the following:
  • Close any error message.
  • Double-click the Pro Tools application.
  • In Pro Tools, choose File > Open Session to open the session.
✦ Reinstall the Pro Tools application, using the Pro Tools Installer disc.

Audio Interface Is Not Recognized

Problem
When you launch Pro Tools it does not recognize an audio interface, or a connected audio interface is not available.

Possible Solutions
✦ Turn off your computer and check to be sure your cables are properly and securely connected to your computer and to your audio interface.
✦ Verify that your Hardware Setup dialog settings are correct.
✦ If you only have one interface, make sure it is connected to the Accel Core (for PCIe) or HD Core (for PCI) card.
✦ Make sure Loop Sync, SuperClock or other synchronization connections to your audio interface are correct. Disconnect the clock source from the interface and see if the problem persists.
Using DigiTest as a Diagnostic Tool

The DigiTest utility performs diagnostic tests on the Pro Tools cards in your system. If DigiTest reports that the Pro Tools|HD Native card has failed, click the Info button next to that card. Write down the information that appears and report it to your local dealer or contact Technical Support.

Running DigiTest

DigiTest is installed with Pro Tools and resides in the following folder on your hard drive: Digidesign/Pro Tools/Pro Tools Utilities.

⚠️ Before you run DigiTest, lower the volume of all output devices. Very loud digital noise may be emitted during the test.

For more information on the DigiTest application, see the DigiTest Guide.

To run DigiTest:

1. Quit Pro Tools if it is running.
2. Lower the volume of all output devices on your system.
3. Locate and double-click the DigiTest icon on your hard drive.

DigiTest opens and lists the supported cards it finds in your system, showing their corresponding slot locations.

4. Select the card in your system you want to test by selecting Test in the left hand column for the card.
5. Click Run.

If the card is not installed correctly, DigiTest will display an error code in the Status box for the card.

6. When prompted, power cycle all Pro Tools peripherals in your system. Click Continue.
7. To test the interfaces connected to your system, check “Test I/O Box.”

💡 LEDs on your audio interfaces may light up during this test. This is normal.
When the test is finished, you can view the test results by doing one of the following:

- Click the Get Results button next to a card name.
- Click the Results tab and choose a card slot from the pop-up menu.

In the Results page of the DigiTest window, click Show Failures Only to display failed tests for the selected card, or click Show All Results to display all test results for the selected card.

For descriptions of error codes, refer to “DigiTest Error Codes” on page 68

Click Quit to close DigiTest.

Restart your computer.

Errors and Undetected Cards

Complete the steps below if any of the following occur:

- DigiTest fails to launch.
- An error message has been displayed for a card in DigiTest.
- A supported card is installed but not automatically detected during DigiTest.

If a supported card is installed and is not automatically detected:

1. Quit DigiTest.
2. Turn off the entire Pro Tools system.
3. Reinstall the Pro Tools|HD Native card.
4. Check the card seating.
5. Turn on the system.
6. Run DigiTest again.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Err3</td>
<td>Cards from different Pro Tools systems are incorrectly mixed. See the configuration chapters.</td>
</tr>
<tr>
<td>Err4</td>
<td>Cards marked with this error are installed in the wrong order. See the configuration chapters.</td>
</tr>
<tr>
<td>Err5</td>
<td>Too many cards of this type are installed in the system. Refer to the Avid website for compatibility information.</td>
</tr>
<tr>
<td>Err6</td>
<td>A card is installed in a reserve slot. For example, a Pro Tools card is installed in the slot reserved for the Expansion Chassis Host Interface card. Refer to the configuration chapters, as well as related installation guides.</td>
</tr>
<tr>
<td>Err1220</td>
<td>SCSI Accelerator card is installed in the wrong slot. See the configuration chapters for correct location of the card.</td>
</tr>
<tr>
<td>Err1221</td>
<td>Expansion Chassis Host Interface card is installed in the wrong slot. See Expanded Systems Guide for correct location of the card.</td>
</tr>
</tbody>
</table>
Identifying Pro Tools Cards with DigiTest

You can use DigiTest to identify which cards are in which slots in your system. This is especially useful if you have multiple Pro Tools cards of the same type installed in your system.

To identify Pro Tools cards with DigiTest

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest icon on your hard drive.

DigiTest opens and lists the supported cards it finds in your system.

3. Open your computer case or expansion chassis so you can see the top edge of the cards installed in your system.

4. In the DigiTest window, select the ID check box next to a card name. The green LED near the top edge of the corresponding card flashes.

Viewing Card Information with DigiTest

DigiTest can display identifying information such as serial number, date of manufacture, and firmware ROM version for each card in your system. This information is useful if you need to contact Technical Support about your Pro Tools hardware.

To display information for a card in your system:

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest icon on your hard drive.
3. Click the Slot Info tab.
4. Choose a card slot from the pop-up menu.
Updating Audio Peripheral Firmware with DigiTest

If firmware updates are available for any of your Pro Tools audio interfaces (HD OMNI, HD I/O, and HD MADI), you can use DigiTest to perform the update. Within DigiTest, the Firmware Update page tells you the firmware version for the selected peripheral and lets you update to a newer version, if necessary.

To update the firmware in a Pro Tools|HD audio interface:

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest application on your hard drive.
3. Click the Audio I/O Firmware tab.
4. Select the card slot from the pop-up menu. If any Pro Tools audio interfaces are connected to the card, the Primary or Secondary options become available in the Device Selection section of the Audio I/O Firmware page.

If any connected interfaces are not recognized, check the connections and power to each interface and click Re-Scan.

5. Under Device Selection, select one of the following options for the corresponding connected audio interface and to view the firmware version for the corresponding interface. (The firmware version is displayed just below the Device Selection section of the Firmware page):
   - Connector 1, Primary
   - Connector 1, Secondary
   - Connector 2, Primary
   - Connector 2, Secondary

6. If the firmware version is not current, click Begin Update to update the firmware for the selected audio interface.

The status of the firmware update process is displayed in the status area at the bottom of the Firmware page.

7. After the update process is complete, click Quit to close DigiTest.
Performance Factors

There are several conditions that may adversely affect the performance of Pro Tools. These include:

Network Connections Close any network connections unless you are using them for network interchange of audio data.

Background Applications Any software utilities that run in the background or generate disk activity, such as virus protection, disk optimization, or file savers, should be turned off or removed.

Screen Savers Screen saver software should be completely disabled on your computer before running Pro Tools.

Power Saver Features Some automatic power saver features, such as those that spin down the system hard drive, can affect Pro Tools performance. These features should be turned off.

Before You Call Avid

Register Your System

Register your purchase immediately after reviewing the Registration Information Card included with every Pro Tools system. Registering your purchase is the only way you become eligible to receive complimentary technical support and future upgrade offers. Registering is one of the most important steps to complete as a new user.

Gather Important Information

Avid wants to help you resolve problems as quickly and efficiently as possible. If you have the following information handy when you contact Technical Support, it will make the diagnosis of your problem easier. Take a few minutes to collect the following basic information:

System Information

Computer

- Make, model, processor speed
- Amount of system RAM
- Operating system (version of Windows or Mac OS)
- Any Drivers, Disk Utilities, or other system-related applications you may have installed

Pro Tools Hardware

- Type of cards, interfaces, or peripherals
- Where the cards are installed
- PCI or PCIe card order in computer or chassis
- Interfaces connected to each card

Hard Drives

- Make, Model
- Drive size (GB)
- Drive speed (RPM)
- Drive type (SCSI, FireWire, IDE/ATA)
- Utility used to format the drive
- Number and size of partitions on the drive

Pro Tools Software

- Pro Tools software version
- Plug-In versions
- Other Pro Tools software options or components
- Additional plug-ins from Avid Development Partners
**Other Hardware**

Refer to the manufacturer’s documentation for operational details.

The most common hardware additions include:

- 1394 (FireWire) cards for Windows systems (manufacturer, model)
- Expansion Chassis (manufacturer, model, bridge chip type)
- Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use with your Pro Tools system, refer to our website (www.avid.com).

**Other Software**

If you are using other audio or video applications, refer to the manufacturer’s documentation for operational details.

Make note of any other software that was running when a problem occurred.

**Diagnostic Information**

**DigiTest**

If you run DigiTest, be sure to make a note of any error codes or messages it generates.

**Other Information**

Note any DAE errors or other error codes you encounter. Additionally, note the ability to reproduce the problem under different conditions, for example, with another session, or after changing settings (such as the Hardware Buffer Size).
Whether you are new to Pro Tools or just starting out with your new system, we encourage you to read and utilize the many guides provided with Pro Tools. There are also useful online resources available, giving you everything from Pro Tools tips and tricks to Pro Tools troubleshooting and solutions.

### About the Pro Tools Guides

In addition to any printed guides included with your system, PDF versions of these guides and many additional Pro Tools guides and Read Mes are installed automatically with Pro Tools. The PDFs are located in the Digidesign/Documentation folder on your local drive.

- **Printed copies of the Pro Tools Reference Guide and other guides in the Pro Tools guide set can be purchased separately from the Avid Store (http://shop.avid.com).**

### Printed User Guide

This printed Pro Tools|HD Native User Guide for your system gives you detailed instructions for setting up and configuring software and hardware for optimum performance.

### Pro Tools Reference Guide

The Pro Tools Reference Guide provides detailed descriptions of all Pro Tools software features, as well as helpful workflows for performing tasks in Pro Tools. While the printed Pro Tools Reference Guide is not included with Pro Tools|HD Native systems, it can be purchased separately from the Avid Store online at our website (http://shop.avid.com).

### Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from the Pro Tools Help menu. (Choose Help, then select a guide.)

These include:

- **Pro Tools Shortcuts Guide**, which provides a complete list of keyboard and Right-click shortcuts for Pro Tools.
- **Audio Plug-Ins Guide**, which describes the audio plug-ins included with Pro Tools (as well as several plug-ins available for purchase separately) for both real-time and file-based audio processing.
- **Pro Tools Menus Guide**, which covers all the Pro Tools on-screen menus.
Documentation Installed Automatically with Pro Tools

When you install Pro Tools, you get useful PDF versions of many Pro Tools guides and Read Mes. This documentation can be found in the following locations:

Mac Applications/Digidesign/Documentation

Windows C:\Program Files\Digidesign\Documentation

To view or print PDF guides, you can use Adobe Reader (recommended) or Apple Preview (Mac only).

Read Me Files

These contain late-breaking information and known issues pertaining to Pro Tools software and hardware configurations. Read Me files are installed in Documentation folder when you install Pro Tools.

Helpful Online Resources

Once you get going, here are some helpful online resources:

- Get useful information, help, and tips from the worldwide community of Pro Tools users at the online User Conference. Go to: http://duc.avid.com
- For questions about installation, visit Avid’s online Knowledge Base. Go to: www.avid.com/onlinesupport
- If you can’t find your answer on the User Conference or the Knowledge Base, contact Avid email support directly. Go to: http://www.avid.com/support

About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on the User Conference.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Avid or sign up for a Pro Tools demo.

Pro Tools Accelerated Videos Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins quickly.
Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

Recycle symbol
**EMC (Electromagnetic Compliance)**

Avid declares that this product complies with the following standards regulating emissions and immunity:

- FCC Part 15 Class A
- EN55103-1 E4
- EN55103-2 E4
- AS/NZS CISPR 22 Class A
- CISPR 22 Class A

**FCC Compliance for United States**

**Radio and Television Interference**

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.

**DECLARATION OF CONFORMITY**

We, Avid, 75 Network Drive
Burlington, MA 01803, USA
650-731-6300

declare under our sole responsibility that the product
Pro Tools|HD Native
complies with Part 15 of FCC Rules.

Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,
including interference that may cause undesired operation.

**Communication Statement**

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
- Reorient or locate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Avid, could void the user’s authority to operate the equipment.

**Australian Compliance**

Avid

**Canadian Compliance**

This Class A digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada

**Taiwan Compliance**

警告使用者：
這是甲類的資訊產品，在居住的環境中使用時，可能會造成射頻干擾，在這種情況下使用者會被要求採取某些適當的對策。

**CE Compliance**

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC directive 2004/108/EC and low voltage directive 2006/95/EC.
**Safety Compliance**

**Safety Statement**

This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th /IEC 60065 7th and Canadian CAN/CSA C22.2 No. 60065-2003 /A1:2006. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

**Warning**

![CAUTION RISK OF ELECTRIC SHOCK DO NOT OPEN]

**Important Safety Instructions**

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long periods of time.

14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.

15) For products that are a Mains powered device: The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.

**Warning**! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

16) For products containing a lithium battery: **CAUTION!** Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.

17) The equipment shall be used at a maximum ambient temperature of 40° C.

18) Use only with Listed ITE equipment.
Numerics
192 Digital I/O 6
192 I/O 6
96 I/O 7
96i I/O 7

A
Application Files (Required for Pro Tools) 16, 22
ASIO Control Panel 57
ASIO driver (Windows) 57
capabilities 57
control panel 57
installing 57
limitations 57
audio drivers
ASIO driver (Windows) 57
CoreAudio driver (Mac) 47
audio interfaces 3
connecting 12, 13
firmware 70
HD I/O 4
HD MADI 5
HD OMNI 3
heat and ventilation 12
Pro Tools HD 3
Audio MIDI Setup (AMS) (Mac) 53
automatic delay compensation 31, 64
Avid Unity 42
Avid Video Engine 16, 22
Avid website 74

D
DAE Playback Buffer Size 32
Delay Compensation 31, 64
enabling 64
Demo session
Mac 18
Windows 24
DigiLink Mini ports 3
DigiRack Plug-Ins 16, 22
DigiSerial port 3
DigiTest 67
troubleshooting 68
disk buffering 32
drive formatting
Windows 43
drives 43
formatting (Mac) 42
formatting (Windows) 43
maintenance 41
requirements 8
DSP delays 63
automatic delay compensation 31, 64

E
Energy Saver (Mac), turning off 19
error codes
DigiTest 68
error suppression 30
Ext. Clock Output 36
FireWire hard drives
  FireWire requirements 42
firmware
  audio interfaces 70

hard drives
  de-fragmenting (Mac) 44
  de-fragmenting (Windows) 44
  drive formats 41
  FireWire 42
  formatting 43
  formatting (Mac) 42
  formatting (Windows) 43
  IDE/ATA requirements 42
  Mac formatted drives on Windows 45
  maintenance 41
  optimizing 45
  partitioning 44
  requirements 8
  space requirements 45
Hardware Buffer Size 28
Hardware Setup
  Ext. Clock Output 36
HD I/O 4
  Analog Expansion cards 4
  analog I/O 4
  configurations 4
  Digital Expansion cards 4
  Digital I/O 4
  synchronization 5
HD MADI 5
HD OMNI 3
  analog I/O 3
  digital I/O 3
  features 3
  monitoring 4
  synchronization 4
HFS+ 45
Host Engine 30
Host Processors setting 29

IDE/ATA requirements 42
Ignore Errors During Playback/Record option 30
installation
  Pro Tools options (Mac) 16
  Pro Tools options (Windows) 22
  Pro Tools|HD Native card (Mac) 10
  Pro Tools|HD Native card (Windows) 11
installations
  Pro Tools (Mac) 15
  Pro Tools (Windows) 21
installing Pro Tools (Mac) 15, 21
installing QuickTime (Windows) 23

journaling (Mac), enabling 20

Loop Sync
  connecting 13
low latency monitoring
  Bounce to Disk 40
  Low Latency Monitoring option 39
  Low Latency Monitoring path 39

Mac HFS+ Disk Support option 22
Mac Pro 9
MIDI
  setup (Mac) 53
  setup (Windows) 59
  supported interfaces 8
MIDI I/O Driver 16
MIDI Studio Setup (MSS) (Windows) 59

Operations menu
  Low Latency Monitoring option 39
optimizing hard drives 45
Options menu
  Delay Compensation option 64

partitioned drives 44
partitioning hard drives 44
PCI Express (PCIe) 9
Peripherals list 35, 36
phase 63
Playback Engine
   Cache Size 32
   CPU Usage Limit 30
   DAE Playback Buffer 32
   Delay Compensation 31
   Host Engine option 30
   Host Processors setting 29
   Ignore Errors During Playback/Record 30
Plug-In Streaming Buffer 33
Plug-in Streaming Buffer Size 33
plug-ins
   Host Processors setting 29
power
   management settings (Windows) 25
Pro Tools
   capabilities 2
   configuration 28
   demo session (Mac) 18
   demo session (Windows) 24
   installation options (Mac) 16
   installation options (Windows) 22
   installing (Mac) 15
   installing (Windows) 21
   launching (Mac) 17
   launching (Windows) 23
   removing (Mac) 18
   removing (Windows) 24
Pro Tools Utilities 16, 22
Pro Tools|HD Native card
   installation (Windows) 11
   installing (Mac) 10
Pro Tools|HD Native PCIe card 2
Processor Scheduling performance (Windows) 26
Program Change dialog 56, 62
QuickTime
   installing (Windows) 23
registration information 8
removing Pro Tools
   Mac 18
   Windows 24
sample delays 63
Sample Rate 34
screen savers 71
Setup menu
   I/O Setup 37
Software Update (Mac), turning off 19
Spotlight indexing (Mac), disabling 20
Startup items (Windows), disabling 26
SYNC peripheral
   DigiSerial port 3
system
   optimization (Mac) 19
   optimization (Windows) 25
   shutting down 27
   starting up 27
system requirements 7
system settings
   Cache Size 32
   Clock Source 34
   CPU Usage Limit 30
   Hardware Buffer Size 28
   Host Engine 30
   I/O Setup 37
   Plug-In Streaming Buffer 33
   Plug-in Streaming Buffer Size 33
   Sample Rate 34
time alignment 63
uninstalling Pro Tools
   Mac 18
   Windows 24
User Account Control (UAC)
   disabling 25
Word Clock 36
www.avid.com 74